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Section 1 – Implement and Manage Storage 

Objective 1.1 – Implement and Manage Complex Storage Solutions 

 

Knowledge 

 Identify RAID Levels 

o RAID 0 – A striped set or volume that splits data evenly across two or more disk. Offers 

superior I/O performance but does not provide data redundancy. 

 Advantages 

 RAID 0 offers great performance in both read and write operations 

 All storage capacity can be used 

 Easy to implement 

 Disadvantages 

 Is not fault-tolerant. Loose one disk all data in the array is lost 

o RAID 1 – Also known as a “mirror”. Data is stored twice by writing to a data disk (or set of 

disks) and a mirror disk (or set of disks). Minimum of two disks needed to create. If a disk 

fails data is recreated via the use of the data or mirror disk 

 Advantages 

 Offers excellent read speed 

 In case of disk failure data does not need to rebuilt from parity, it is copied 

over to the replacement disk 

 Easy to implement 

 Disadvantages 

 Effective storage capacity is half of the total disk space 

o RAID 5 – Uses block level striping of data with single parity across all member disks of the 

array. Can withstand a single disk failure without losing data or access to data. Minimum of 

three drives needed to create 

 Advantages 

 Read transactions are fast 

 Disadvantages 

 Write transactions are slower due to parity being calculated 

 Disk failures have an effect on data throughput 

 Somewhat complex to implement 

o RAID 6 – Uses block level striping of data with dual parity across all member disks of the 

array. Can with stand two disk failures without losing data or access to data. Minimum of 

four drives needed to create 

 Advantages 

 Read transactions are fast 

 Disadvantages 

 Write transactions are slower due to parity being calculated 
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 Disk failures have an effect on data throughput 

 Somewhat complex to implement 

 Identify Supported HBA Types 

o Supported Fibre Channel HBA’s 

 QLogic 

 Emulex 

o Supported iSCSI Hardware HBA’s 

 QLogic 

(Source: VMware SAN System Design and Deployment Guide) 

 Identify Virtual Disk Format Types 

o Thin – Space required for the virtual disk is not allocated during creation, but is supplied and 

zeroed out, on demand at a later time 

o Thick – Space required for the virtual disk is allocated during creation. This type of 

formatting does not zero out any old data that might be present on this allocated space. A 

non-root user cannot create disks of this format  

o RDM – Virtual compatibility mode (pass-through) for a raw disk mapping 

o Zeroedthick (default) – Space required for the virtual disk is allocated during the creation of 

the disk file. Any data remaining on the physical device is not erased during creation. But is 

zeroed out on demand at a later time on first write from the virtual machine. The virtual 

machine does not read stale data from disk 

o Eagerzeoedthick – Space required for the virtual disk is allocated at creation time. In 

contrast to zeroedthick format, the data remaining on the physical device is zeroed out 

during creation. It might take much longer to create disks in this format than to create other 

types of disks.  

o 2gbsparse – A sparse disk with 2GB maximum extent size. You can use disks in this format 

with other VMware products, however, you cannot power on sparse disk on a ESX host till 

you report the disk with vmkfstools in a compatible format, such as thick or thin 

o Monosparse – A monolithi sparse disk. You can use disks in this format with other VMware 

products 

o Monoflat – A monolithic flat disk. You can use disks in this format with other VMware 

products 
(Source: VMware KB 1022242) 

Skills and Abilities 

 Determine Use Cases For And Configure VMware DirectPath I/O 

o VMware DirectPath I/O allows a guest operating system to directly access an I/O device on a 

host, bypassing the virtualization layer. This direct path, or pass through can improve 

performance for VMware ESX systems that utilize high-speed I/O devices, such as 10 Gigabit 

Ethernet. 

o Should be used only on the most demanding of virtual machine types, SQL, SAP, etc… 
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o The following features are unavailable for virtual machines configured with VMDirectPath 

 vMotion 

 Hot adding and removing virtual devices 

 Suspend and Resume 

 Record and Replay 

 Fault Tolerance 

 High Availability 

 DRS (limited availability; the virtual machine can be part of a cluster, but cannot 

migrate across hosts) 

o Configuring VMware DirectPath I/O on an ESX host 

1. Select and ESX host from the Inventory panel from the vSphere Client 

2. Select the Configuration tab, click Advanced Settings. The Pass-Through 

Configuration page lists all available pass-through devices 

3. Click Edit 

4. Select the devices to be used for pass through and click OK 

5. When the devices are select, they are marked with an orange icon. Reboot for the 

change to take effect. After rebooting, the devices are marked with a green icon and 

are enabled 

o Configuring VMware DirectPath I/O on a virtual machine 

1. From the Inventory in the vSphere Client, right click the virtual machine and choose 

Edit Settings 

2. Click the Hardware tab 

3. Click Add 

4. Choose the PCI device 

5. Click Next 

(Sources: VMware - Configuration Examples and Troubleshooting for VMDirect Path & VMware KB 1010789) 

 Determine Requirements For and Configure NPIV 

o N-Port ID Virtualization (NPIV) is an ANSI T11 standard that describes how a single Fibre 

Channel HBA port can register with the fabric using several worldwide port names 

(WWPNs). This allows a fabric-attached N-port to claim multiple fabric addresses. Each 

address appears as a unique entity on the Fibre Channel fabric 

o Requirements for Using NPIV 

 NPIV can only be used for virtual machines with RDM disks. Virtual machines with 

regular virtual disks use the WWNs of the host’s physical HBAs 

 For this implementation of NPIV, the physical HBAs on an ESX/ESXi host, using their 

own WWNs, must have access to all LUNs that are to be accessed by virtual 

machines running on that host 

 The ESX/ESXi host’s physical HBAs must support NPIV. Search for NPIV-supported 

HBAs in the VMware Compatibility Guide to check for ESX/ESXi support. Refer to 

specific vendor for information on NPIV supported HBAs. 
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 Only four WWN pairs are generated per virtual machine 

 When a virtual machine or template with a WWN assigned to it is cloned, the clones 

do not retain the WWN 

 The switches used must be NPIV-aware 

 When configuring an NPIV LUN for access at the storage level, make sure that the 

NPIV LUN number and PNIV target ID match the physical LUN and Target ID 

 Always use the vSphere Client to manipulate virtual machines with WWNs 

o Assigning WWN’s to Virtual Machines 

1. Start the New Virtual Machine wizard 

2. Select Custom and click Next 

3. Complete the steps for creating a custom virtual machine 

4. On the Disk Selection Page choose Raw Device Mapping and click next 

5. From a list of SAN disks or LUNs, select a raw LUN you want your virtual machine to 

access directly 

6. Select a datastore for the RDM mapping file NOTE – If you want to use vMotion for a 

virtual machine with NPIV enabled, make sure that the RDM file is located on the 

same datastore where the virtual machine configuration file resides 

7. Follow the steps required to create a virtual machine with the RDM 

8. On the Ready to Complete page, select the Edit the virtual machine settings before 

completion check box and click Continue 

9. Assign WWNs to the virtual machine 

a) Click the Options tab, and select Fibre Channel NPIV 

b) Select Generate new WWNs 

c) Specify the number of WWNNS and WWPNs 

o A minimum of 2 WWPNs are needed to support failover with NPIV. 

Typically only 1 WWNN is created for each virtual machine 

10. Click Finish 

11. The host creates WWN assignments for the virtual machine 

(Source: VMware Fibre Channel SAN Configuration Guide) 

 Determine Appropriate RAID Level For Various Virtual Machine Workloads 

 Apply VMware Storage Best Practices 

o Fibre Channel and General Best Practices 

 If you have heavy disk I/O loads, you may need to assign separate storage 

processors to separate systems to handle the amount of traffic bound for storage 

 To optimize storage array performance, spread I/O loads over the available paths to 

the storage (across multiple host bust adapters (HBAs) and storage processors (SPs)) 

 Configure maximum queue depth for HBA cards. For additional information see 

VMware KB 1267 

 In order to use VMware Storage vMotion you storage infrastructure must provide 

sufficient available storage bandwidth. 
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 For active-active arrays with fixed failover policy, designate active paths to each 

logical unit of storage. Doing so allows for the best possible use of your bandwidth 

to the disk array 

o iSCSI and NFS Best Practices 

 Make sure your network topology does not contain Ethernet bottlenecks, where 

multiple links are routed through fever links, potentially resulting in 

oversubscription and dropped network packets. Recovering from dropped network 

packets results in larger performance degradation, In addition to time spent 

determining that data was dropped, the retransmission uses network bandwidth 

that could otherwise be sued for new transactions. 

 Applications or systems that write large amounts of data to storage, such as data 

acquisition or transaction logging systems, should not share Ethernet links to a 

storage device. These types of applications perform best with multiple connections 

to storage devices 

 Performance design for a storage network must take into account the physical 

constraints of the network, not logical allocations. Using VLANs or VPNs does not 

provide a suitable solution to the problem of link oversubscription in share 

configurations. VLANs and other virtual partitioning of a network provide a way of 

logically configuring a network, but don’t change the physical capabilities of links 

and trunks between switches 

 If the network switch deployed for the data path supports VLAN, it is beneficial to 

create a VLAN just for the ESX hosts’ vmknic and the NFS/iSCSI server. This 

minimizes network interference from other packet sources 

 Be aware that with software-initiated iSCSI and NAS the network protocol 

processing takes place on the host system, and thus these can require more CPU 

resources than other storage options 

o iSCSI and NFS Advanced Configurations 

 For iSCSI set the Disk.UseLunReset to 1 

 For iSCSI set the Disk.UseDeviceReset to 0 

 For iSCSI allow ARP redirection if the store system supports transparent failover 

 For iSCSI a multipathing policy of Most Recently Used must be set for all LUNs 

hosting clustered disks for active-passive arrays. A multipathing policy of MRU or 

Fixed may be set for LUNs on active-active arrays 

 For NFS increase the NFS.MaxVolumes to 64 

 For NFS increase the Net.TcpOpHeapSize to 30 

 For NFS increase the Net.TcpIpHeapMax to 120 

 For NFS increase the NFS.HearbeatFrequency to 12 

 For NFS increase the NFS.HeartbeatTimeout to 5 

 For NFS increase the NFS.HeartbeatMaxFailures to 10 
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(Sources: VMware Performance Best Practices for VMware vShpere 4.0, VMware White Paper – Best Practices for Running 

VMware vSphere on NFS, VMware iSCSI SAN Configuration Guide, VMware Fibre Channel SAN Configuration Guide, VMware 

SAN System Design and Deployment Guide) 

 Understand Use Cases For RAW Device Mappings (RDMs) 

o RDM is a mapping file in a separate VMFS volume that acts as a proxy for a raw physical 

device, a SCSI device used directly by a virtual machine. The RDM contains metadata for 

managing and redirecting disk access to the physical drive 

o Uses Case for RDMs 

 When SAN snapshot or other layered applications are run in the virtual machine. 

The RDM better enables scalable backup offloading systems by using features 

inherent to the SAN 

 In any MSCS clustering scenario that spans physical hosts – virtual to virtual clusters 

as well as physical-to-virtual clusters. In this case, cluster data and quorum disks 

should be configured as RDMs rather than as files on a shared VMFS. 

o Using RDMs, you can: 

 Use vMotion to migrate virtual machines using raw LUNs 

 Add raw LUNs to virtual machines using the vSphere Client 

 Use file system features such as distributed file locking, permissions, and naming 

o Limitations of Raw Device Mappings 

 Not available for block devices or certain RAID devices 

 Available with VMFS-2 and VMFS-3 volumes only 

 No snapshots in physical compatibility mode, snapshots are available in virtual 

mode 

 No partition mapping – RDM requires the mapped device to be a whole LUN 

o Two Compatibility modes are available for RDMs 

 Virtual compatibility mode allows an RDM to act exactly like a virtual disk file, 

including the use of snapshots 

 Physical compatibility mode allows direct access of the SCSI device for those 

applications that need lower level control 

o Benefits of Raw Device Mapping 

 User-Friendly Persistent Names 

 Dynamic Name Resolution 

 Distributed File Locking 

 File Permissions 

 File System Operations 

 Snapshots 

 vMotion 

 SAN Management Agents 

 N-Port ID Virtualization (NPIV) 

(Sources: VMware ESX Configuration Guide) 
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 Configure vCenter Server Storage Filters 

o When you perform VMFS datastore management operations, vCenter Server uses default 

storage filters. The filters help you to avoid storage corruption by retrieving only the storage 

devices, or LUNs, that can be used for a particular operation. Unsuitable LUNs are not 

displayed for selection. You can turn off the filters to view all LUNs. 

o vCenter Server provides storage filters to help you avoid storage device corruption or 

performance degradation that can be caused by an unsupported use of LUNs. These filters 

are provided by default: 

 VMFS Filter – Filters out storage devices, or LUNs, that are already used by a VMFS 

datastore on any host managed by vCenter Server. The LUNs do not show up as 

candidates to be formatted with another VMFS datastore or to be used as an RDM 

 RDM Filter – Filters out LUNs that are already referenced by an RDM on any host 

managed by vCenter Server. The LUNs do not show up as candidates to be 

formatted with VMFS or to be used by a different RDM.  

 Same Host and Transports Filter – Filters out LUNs ineligible for use as VMFS 

datastore extent because of host or storage type incompatibility. 

 Host Rescan Filter – Automatically rescans and update VMFS datastores after you 

perform datastore management operations. The filter helps provide a consistent 

view of all VMFS datastores on all hosts managed by vCenter Server 

o Turn off vCenter Storage Filters 

1. In the vSphere Client, select Administration > vCenter Server Settings 

2. Select Advanced Settings 

3. In the Key text box, type a key 

a) Config.vpxd.filter.vmfsFilter  VMFS Filter 

b) Config.vpxd.filter.rdmFilter  RDM Filter 

c) Config.vpxd.filter.SameHostAndTransportsFilter  Same Host and 

Transports Filter 

d) Config.vpxd.filter.hostRescanFilter  Host Rescan Filter 

4. In the Value text box, type False for the specified key 

5. Click Add 

6. Click OK 

(Source: VMware ESX Configuration Guide) 

 Understand And Apply VMFS Resignaturing 

o When a LUN contains a VMFS datastore copy, you can mount the datastore with the existing 

signature or assign a new signature. Each VMFS datastore created in a LUN has a unique 

UUID that is stored in the file system superblock. When the LUN is replicated or 

snapshotted, the resulting LUN copy is identical, byte-for-byte, with the original LUN. As a 

result, if the original LUN contains a VMFS datastore with UUID X, the LUN copy appears to 

contain an identical VMFS datastore, or a VMFS datastore copy, with exactly the same UUID 

X. 
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o Use datastore resignaturing to retain the data stored on the VMFS datastore copy. When 

resignaturing a VMFS copy, ESX assigns a new UUID and a new label to the copy, and 

mounts the copy as a datastore distinct from the original. 

o When you perform datastore resignaturing, consider the following points: 

 Datastore resignaturing is irreversible 

 The LUN copy that contains the VMFS datastore that you resignature is no longer 

treated as a LUN copy 

 A spanned datastore can be resignatured only if all its extents are online 

 The resignaturing process is crash and fault tolerant. If the process is interrupted, 

you can resume it later 

 You can mount the new VMFS datastore without a risk of its UUID colliding with 

UUIDs of any other datastore, such as an ancestor or child in a hierarchy of LUN 

snapshots 

o Resignature a VMFS Datastore Copy 

 Prerequisites 

a) To resignature a mounted datastore copy, first unmount it 

b) Before you resignature a VMFS datastore, perform a storage rescan on your 

host to that the host updates its view of LUNs presented to it and discovers 

any LUN copies 

1. Log in to the vSphere Client and select the server from the inventory panel 

2. Click the Configuration tab and click Storage in the Hardware Panel 

3. Click Add Storage 

4. Select the Disk/LUN storage type and click Next 

5. From the list of LUNs, select the LUN that has a datastore name displayed in the 

VMFS Label column and click Next 

6. Under Mounts Options, select Assign a New Signature and click Next 

7. In the Ready to Complete page, review the datastore configuration information and 

click Finish 

o What to do next 

 If the resignatured datastore contains virtual machines, update references to the 

original VMFS datastore in the virtual machine files, including .vmx. .vmdk, .vmsd, 

and .vmsn 

 To power on virtual machines, register them with vCenter Server 

(Source: VMware ESX Configuration Guide) 

 Understand And Apply LUN Masking Using PSA-Related Commands 

o Masking Paths will allow you to prevent an ESX/ESXi host from accessing storage devices or 

LUNs or from using individual paths to a LUN. When you mask paths, you create claim rules 

that assign the MASK_PATH plug-in to the specified paths. Use the vSphere CLI commands 

to mask the paths. 

 Look at the Multipath Plug-ins currently install on your ESX/ESXi host: 
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# esxcfg-mpath –G 

The output indicates that there are, at a minimum, 2 plug-ins: the VMware Native 

Multipath Plug-in (NMP) and the MASK_PATH plug-in, which is used for masking LUNs 

 List all the claimrules currently on the ESX/ESXi host: 

# esxcli corestorage claimrule list 

There are two MASK_PATH entries: one of class runtime and the other of class file 

The runtime is the rules currently running in the PSA. The file is a reference to the rules 

defined in /etc/vmware/esx.conf. These are identical, but they could be different if you 

are in the process of modifying the /etc/vmware/esx.conf 

 Add a rule to hide the LUN with the command 

# esxcli corestorage claimrule add –rule <number> -t location –A <hba_adapter> -C 

<channel> -T <target> -L <lun> -P MASK_PATH 

Note – Use the esxcfg-mpath –b and esxcfg-scsidevs –l commands to identify disk and 

LUN information 

 Verify that the rule has taken with the command: 

# esxcli corestorage claimrule list 

 Reload your claimrules with the command 

#esxcli corestorage claimrule load 

 Re-examine your claim rules and you verify that you can see both the file and 

runtime class: 

# esxcli corestorage claimrule list 

 Unclaim all paths to a device and then run the loaded claimrules on each of the 

paths to reclaim them: 

# esxcli corestorage claiming reclaim –d <naa.id> 

 Verify that the masked device is no longer used by the ESX/ESXi host: 

# esxcfg-scsidevs –m 

The masked datastore does not appear in the list 

 To verify that a masked LUN is no longer an active device 
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# esxcfg-mpath –L | grep <naa.id> 

Empty output indicates that the LUN is not active 

(Source: VMware KB 1009449 and KB 1014953) 

 Analyze I/O Workloads to Determine Storage Performance Requirements 
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Objective 1.2 – Manage Storage Capacity in a vSphere Environment 

 

Knowledge 

 Identify Storage Provisioning Methods 

 Identify Available Storage Monitoring Tools, Metrics, and Alarms 

Skills and Abilities 

 Apply Space Utilization Data to Manage Storage Resources 

 Provision and Manage Storage Resources According to Virtual Machines Requirements 

 Understand Interactions Between Virtual Storage Provisioning and Physical Storage Provisioning 

 Apply VMware Storage Best Practices 

 Configure Datastore Alarms 

 Analyze Datastore Alarms and Errors to Determine Space Availability 
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Objective 1.3 – Configure and Manage Complex Multipathing and PSA Plug-ins 

 

Knowledge 

 Explain the Pluggable Storage Architecture (PSA) layout 

o To manage storage multipathing, ESX uses a special VMkernel layer, the Pluggable Storage 

Architecture (PSA). The PSA is an open, modular framework that coordinates the 

simultaneous operation of multiple multipathing plug-ins. (MMPS) 

The VMkernel mulitpathing plug-in that ESX provides by default is the VMware Native 

Multipathing Plug-In (NMP). The NMP is an extensible module that manages sub plug-ins. 

There are two types of NMP sub plug-ins, Storage Array Type Plug-Ins (SATPs), and Path 

Selection Plug-Ins (PSPs). SATPs and PSPs can be built-in and provided by VMware, or can be 

provided by a third party. 

 

o The Native Multipathing Plug-In (NMP) is the VMware default MPP. If no vendor-supplied 

MPP has been installed and configured, the NMP is used automatically. The NMP comes 

with its own default claim rules. The NMP implements the following tasks: 

 Associates an SATP with each physical storage path 

 Associates physical paths with logical devices 

 Processes I/O requests to logical devices 

 Performs actions necessary to handle failure and request retries using the SATP 

 Selects an optimal physical path for the request (load-balance) using the PSP 

o Storage Array Type Plug-Ins (SATPs) is provided by ESX for every type of array that VMware 

supports. It also provides default SATPs that support non-specific active-active and ALUA 

storage arrays, and the local SATP for direct-attached devices.  

After the NMP determines which SATP to use for a specific storage device and associates the 

SATP with the physical paths for that storage device, the SATP implements the tasks that 

include the following: 

 To implement the switching of physical paths to the array when a path has failed 

 To determine when a hardware component of a physical path has failed 

 To monitor the hardware stat of the physical paths to the storage array 
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o Path Selection Plug-Ins (PSPs) run with the VMware NMP and is responsible for choosing a 

physical path for I/O requests. The NMP assigns a default PSP for each logical device based 

on the SATP associated with the physical paths for that device (You can override the default 

PSP). VMware provides three default PSPs: 

 Fixed 

 Most Recently Used (MRU) 

 Round Robin (RR) 

o VMware NMP Flow of I/O 

 The NMP calls the PSP  assigned to this logical device 

 The PSP select an appropriate physical path to send the I/O, load-balancing the I/O if 

necessary 

 If the I/O operation is successful, the NMP reports its completion. If the I/O 

operation reports an error, the NMP calls an appropriate SATP 

 The SATP interprets the error codes and, when appropriate, activates inactive paths 

and fails over to the new active path 

 The PSP is then called to select a new active path from the available paths to send 

the I/O 

Skills and Abilities 

 Install and Configure PSA Plug-ins 

 Understand Different Multipathing Policy Functionalities 

o Most Recently Used (MRU) is the default PSP. It automatically selects the first working path 

that was discovered at system boot time. If the path fails, the MRU PSP automatically 

switches to an alternate path if one is available. Once the MRU PSP has selected a path it 

will not switch to any other paths (including the initial path), unless the current path fails. 

MRU is the default and required PSP for active-passive arrays and any storage arrays that us 

asymmetrical logical unit access (ALUA) 

o Fixed path uses a designated preferred path. If that path fails, the Fixed PSP switches to 

some other path. If the designated preferred path becomes available again, the Fixed PSP 

automatically switches to it. Fixed PSP works well with active-active arrays. It does not work 

well with active-passive arrays. 

o Round Robin PSP is the only PSP that provides load balancing. The RR PSP will use only 

active paths, so the RR PSP is most effective when used with active-active arrays. It can be 

used with active-passive arrays. If you assign the RR PSP to an active-passive array it will 

attempt to load-balance between ports on the storage processor. This will work only if 

multiple ports are available 
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 Perform Command Line Configuration of multipathing options 

o List LUN multipathing information 

# esxcfg-mpath –l 

iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8-00023d000002,iqn.1992-

04.com.emc:cx.apm00085002815.a2,t,3-naa.600601605c0023005ed2b48b938          3df11 

   Runtime Name: vmhba35:C0:T1:L0 

   Device: naa.600601605c0023005ed2b48b9383df11 

   Device Display Name: DGC iSCSI Disk (naa.600601605c0023005ed2b48b9383df11) 

   Adapter: vmhba35 Channel: 0 Target: 1 LUN: 0 

   Adapter Identifier: iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8 

   Target Identifier: 00023d000002,iqn.1992-04.com.emc:cx.apm00085002815.a2,t,3 

   Plugin: NMP 

   State: active 

   Transport: iscsi 

   Adapter Transport Details: iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8 

   Target Transport Details: IQN=iqn.1992-04.com.emc:cx.apm00085002815.a2 Alias= 

Session=00023d000002 PortalTag=3 

 

iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8-00023d000002,iqn.1992-

04.com.emc:cx.apm00085002815.b3,t,2-naa.600601605c0023005ed2b48b938          3df11 

   Runtime Name: vmhba35:C1:T3:L0 

   Device: naa.600601605c0023005ed2b48b9383df11 

   Device Display Name: DGC iSCSI Disk (naa.600601605c0023005ed2b48b9383df11) 

   Adapter: vmhba35 Channel: 1 Target: 3 LUN: 0 

   Adapter Identifier: iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8 

   Target Identifier: 00023d000002,iqn.1992-04.com.emc:cx.apm00085002815.b3,t,2 

   Plugin: NMP 

   State: standby 
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   Transport: iscsi 

   Adapter Transport Details: iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8 

   Target Transport Details: IQN=iqn.1992-04.com.emc:cx.apm00085002815.b3 Alias= 

Session=00023d000002 PortalTag=2 

o List all multipathing plug-ins installed on your ESX host 

# esxcfg-mpath –G 

MASK_PATH 

NMP 

o Examine devices that have been claimed by the native multipathing plug-in on your ESX host 

# esxcli nmp device list 

naa.600601605c0023005ed2b48b9383df11 

    Device Display Name: DGC iSCSI Disk (naa.600601605c0023005ed2b48b9383df11) 

    Storage Array Type: VMW_SATP_CX 

    Storage Array Type Device Config: {navireg ipfilter} 

    Path Selection Policy: VMW_PSP_MRU 

    Path Selection Policy Device Config: Current Path=vmhba35:C1:T0:L0 

    Working Paths: vmhba35:C1:T0:L0 

o List default installed SATPs 

# esxcli nmp satp list 

 Name                 Default PSP    Description 

VMW_SATP_ALUA_CX     VMW_PSP_FIXED  Supports EMC CX that use the ALUA protocol 

VMW_SATP_SVC         VMW_PSP_FIXED  Supports IBM SVC 

VMW_SATP_MSA         VMW_PSP_MRU    Supports HP MSA 

VMW_SATP_EQL         VMW_PSP_FIXED  Supports EqualLogic arrays 

VMW_SATP_INV         VMW_PSP_FIXED  Supports EMC Invista 

VMW_SATP_SYMM        VMW_PSP_FIXED  Supports EMC Symmetrix 
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VMW_SATP_LSI         VMW_PSP_MRU    Supports LSI and other arrays compatible with the SIS 6.10 in non-

AVT mode 

VMW_SATP_EVA         VMW_PSP_FIXED  Supports HP EVA 

VMW_SATP_DEFAULT_AP  VMW_PSP_MRU    Supports non-specific active/passive arrays 

VMW_SATP_CX          VMW_PSP_MRU    Supports EMC CX that do not use the ALUA protocol 

VMW_SATP_ALUA        VMW_PSP_MRU    Supports non-specific arrays that use the ALUA protocol 

VMW_SATP_DEFAULT_AA  VMW_PSP_FIXED  Supports non-specific active/active arrays 

VMW_SATP_LOCAL       VMW_PSP_FIXED  Supports direct attached devicesp satp list 

o List default installed PSPs 

# esxcli nmp psp list 

Name             Description 

VMW_PSP_MRU     Most Recently Used Path Selection 

VMW_PSP_RR       Round Robin Path Selection 

VMW_PSP_FIXED   Fixed Path Selection 

 Change a Multipath Policy 

o Changing the PSP for a storage device via the vCLI 

 Obtain the NAA ID and the Runtime Nam 

# esxcfg-mpath –l 

iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8-00023d000002,iqn.1992-

04.com.emc:cx.apm00085002815.a2,t,3-naa.600601605c0023005ed2b48b9383df11 

   Runtime Name: vmhba35:C0:T1:L0 

   Device: naa.600601605c0023005ed2b48b9383df11 

   Device Display Name: DGC iSCSI Disk (naa.600601605c0023005ed2b48b9383df11) 

   Adapter: vmhba35 Channel: 0 Target: 1 LUN: 0 

   Adapter Identifier: iqn.1998-01.com.vmware:vcc-tst-esx01-041086a8 

   Target Identifier: 00023d000002,iqn.1992-04.com.emc:cx.apm00085002815.a2,t,3 

   Plugin: NMP 

   State: active 
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   Transport: iscsi 

 Determine the existing PSP for the storage device 

# esxcli nmp device list –device naa.600601605c0023005ed2b48b9383df11 <naa.id> 

naa.600601605c0023005ed2b48b9383df11 

    Device Display Name: DGC iSCSI Disk (naa.600601605c0023005ed2b48b9383df11) 

    Storage Array Type: VMW_SATP_CX 

    Storage Array Type Device Config: {navireg ipfilter} 

    Path Selection Policy: VMW_PSP_MRU 

    Path Selection Policy Device Config: Current Path=vmhba35:C1:T0:L0 

    Working Paths: vmhba35:C1:T0:L0 

 Change the PSP to Fixed 

# esxcli nmp device setpolicy –device naa.600601605c0023005ed2b48b9383df11 –P 

VMW_PSP_FIXED 

 Verify that the change has been made 

# esxcli nmp device list –device naa.600601605c0023005ed2b48b9383df11 

naa.600601605c0023005ed2b48b9383df11 

    Device Display Name: DGC iSCSI Disk (naa.600601605c0023005ed2b48b9383df11) 

    Storage Array Type: VMW_SATP_CX 

    Storage Array Type Device Config: {navireg ipfilter} 

    Path Selection Policy: VMW_PSP_FIXED 

    Path Selection Policy Device Config: {preferred=vmhba35:C0:T2:L0;current=vmhba35:C0:T2:L0} 

    Working Paths: vmhba35:C0:T2:L 

o Changing the PSP for a storage device via the vSphere Client 

1. Select an ESX/ESXi host from the Hosts and Clusters inventory view 

2. Click the Configuration Tab and Select storage under Hardware 

3. Select a Datastore from either the Datastores or Devices view 

4. Click Properties on the far right of the Datastore Details 

5. Click Manage Paths 
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6. Select a path and choose a Path Selection Policy from the pull down and click 

Change 

7. Click Close 

(Sources: VMware vSphere: Troubleshooting Student Manual, VMware ESX Configuration Guide) 

 Configure Software iSCSI Port Binding 

o If using two or more physical NICs for software iSCSI connectivity you can “bind” the 

interfaces together for greater throughput and multi-pathing. There are two ways of 

implementing such a solution. The first uses a separate vSwitch per VMkernel port group, 

the second uses a single vSwitch with multiple port groups. In this example we will be using 

the second approach utilizing two physical NICs. To do so complete the following steps: 

 Create a new vSwitch 

# esxcfg-vswitch –a vSwitch1 

 Create two port groups  - ie IPStorage-1 and IPStorage-2 

#esxcfg-vswitch vSwitch1 –A <port group name> 

 Create multiple vmkernel NICs. 

# esxcfg-vmknic –a –I <IP Address> -n <Subnet Mask> 

 Add the physical NICs to the vSwitch 

# esxcfg-vswitch –L <vmnic> 

 Map each iSCSI port group to a single active NIC 

o Enter the properties of the vSwitch  

o Select one of the iSCSI port groups and choose Edit 

o Select the NIC Teaming tab and check the Override vSwitch Failover Order 

o Assign only one adapter as active and move all remaining adapters to the 

Unused Adapters area 

o Complete this step for all remaining iSCSI port groups 

 Identify the vmhba name for the iSCSI Software Adapter 

o Select a host in the vSphere Client 

o Navigate to the Configuration tab and select Storage Adapters 

o Make note of the vmhba name (ex. Vmhba35) 

 Collect the vmkernel iSCSI port names 

# esxcfg-vmknic –l 

 Bind each vmkernel port to the software iSCSI adapter 

# esxcli swiscsi nic add –n <vmk #> -d <vmhba device> 
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 Verify vmhba configuration 

# esxcli swiscsi nic list –d <vmhba device> 

(Sources: iSCSI SAN Configuration Guide) 
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Section 2 – Implement and Manage Networking 

Objective 2.1 – Implement and Manage Complex Virtual Networks 

 

Knowledge 

 Identify Common Virtual Switch Configurations 

o More focused around best practices 

 Redundant uplinks for vSwitches 

 Separate network traffic from VMkernel ports and VM traffic (VLANs, dedicated 

pNICS) 

 Select the appropriate Load Balancing for your configuration 

 Dedicated vSwitch for IP based storage (iSCSI, NFS) 

 Secure network for Service Console 

Skills and Abilities 

 Determine Use Cases For and Apply IPv6 

o IPv6 is the successor to IPv4. The major difference between IPv6 and IPv4 is that IPv6 uses a 

128-bit address rather than the 32-bit addresses used by IPv4. This helps alleviate the 

problem of address exhaustion that is present with IPv4 and eliminates the need for 

network address translation (NAT). 

o ESX 4.0 supports IPv6 with the following restrictions: 

 IPv6 Storage (software iSCSI and NFS) is experimental in ESX 4.0 

 ESX does not support TCP Segmentation Offload (TSO) with IPv6 

 VMware High Availability and Fault Tolerance do not support IPv6 

o By default IPv6 is disabled and must be enabled on a host 

 Select a host from the vSphere Client 

 Click the Configuration tab, Select Networking, and click Properties 

 In the pop up window select Enable IPv6 support on this host system 

 Click OK 

 Reboot the host for the changes to take effect 

o To enable IPv6 via the CLI 

 To enable IPv6 for the VMkernel, run  the command 

# esxcfg-vmknic -6 true 

 To enable IPv6 for the Service Console, run the command 

# esxcfg-vswif -6 true 

 To verify that IPv6 has been enabled, run the command 

# vmkload_mod –l 
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(Sources: VMware KB 1010812) 

 Configure NetQueue 

o NetQueue in ESX takes advantage of the ability of some network adapters to deliver 

network traffic to the system in multiple receive queues that can be processed separately, 

allowing processing to be scaled to multiple CPUs, improving receive-side networking 

performance. NetQueue is enabled by default in ESX/ESXi 

o To enable NetQueue  on a host via the CLI use the following command 

# vicfg-advcfg –set true VMkernel.Boot.netNetQueueEnable 

o To configure a supported NIC use the following CLI command 

# vicfg-module.pl <conn_options> -s “intr_type_2 rx_ring_num=8” s2io 

o To verify that NetQueue has been configured use the following CLI command 

# vicfg-module.pl <conn_options> -g s2io 

(Sources: VMware vSphere Command-Line Interface Installation and Reference Guide, VMware ESX Configuration Guide) 

 Configure SNMP 

o SNMP can be configured either via directly editing the /etc/snmp/snmpd.conf file or using 

the vMA with the vicfg-snmp command. I will be outlining the process via the vicfg-snmp 

command. 

 Specify the communities and trap targets 

# vicfg-snmp –t <target hostname>@<port>/<community> 

Ex. Vicfg-snmp –t snmp.domain.com@162/public 

 Enable the SNMP service 

# vicfg-snmp –E 

 Send a test trap to verify that the agent is configure correctly 

# vicfg-snmp –T 

(Source: VMware KB 1008065) 

 Determine Use Cases For and Apply VMware DirectPath I/O 

o For VMDirectPath I/O to function you need to be running a supported Intel or AMD 

implementation of I/O Memory Management Unit (IOMMU). Intel’s implementation is 

called Virtual Technology for Directed I/O (VT-d). AMD’s solution is called AMD IOMMU, but 

is offered as experimental support. NOTE – Some machines might not have this technology 

enabled in the BIOS by default. 

o Verify IOMMU is enabled after ESX is booted via the CLI 

mailto:snmp.domain.com@162/public
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# esxcfg-module –l 

o While many devices work fine in the virtual machine with the default settings, advanced 

configuration is sometimes necessary in the following cases: 

o If you are able to boot the virtual machine configured with pass-through devices 

o If the device is not working properly inside the virtual machine 

o You know a specific configuration is required 

o See Objective 1.1 for further information 

(Source: VMware Configuration Examples and Troubleshooting for VMDirectPath) 

 Migrate a vSS Network to a Hybrid or Full vDS Solution 

o Migration from a vNetwork standard Switch only environment to one featuring one or more 

vNetwork Distributed Switches can be accomplished in either of two ways: 

 Using only the vDS User Interface (vDS UI) 

 Using a combination of the vDS UI and Host Profiles 

o Table of Migration Methods 

 

o Migration Process Work Flow 
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o Host Migration with some Disruption to VMs – The process outlined in Step 3 above includes 

two sub-steps 

 Migration of vmnics and virtual ports (VMkernel ports and Service Consoles) can be 

migrated in a single step from vCenter Server 

 Migration of VM Networking where the VMs are migrated from vSS Port Groups to 

vDS DV Port Groups 

If all vmnics are migrated in the first step above then all VMs will lose network connectivity until 

the following step is completed. 

o Host Migration without Disruption to VMs – If you need completely non-disruptive 

migration for VMs while deploying vDS, then a phased vmnic migration is required. The 

objective of a phased migration of vmnics is to maintain concurrent network connectivity 

over both vSS and vDS switches so that VM migration from vSS Port Groups to vDS DV Port 

Groups can proceed without interruption to network sessions. 

Step 3 of the non-disruptive process based on the above flow chart is as follows 

 Add host to vDS 

 Migrate one vmnic from the NIC team supporting VM networking from vSS to vDS 

dvUplink 

 Migrate VM networking from vSS Port Groups to vDS DV Port Groups 

 Migrate remaining vmnics and virtual ports (vmkernel and Service Consoles) to vDS 

(Sources: VMware White Paper – VMware vNetwork Distributed Switch: Migration and Configuration) 
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 Configure vSS and vDS Settings Using Command Line Tools 

o Several commands exist to configure vSwitches. Some can be used for vDS 

 esxcfg-vswitch – Examine and configure virtual switches 

 esxcfg-vswif – Examine and configure service console ports 

 esxcfg-vmknic – Examine and configure VMkernel ports 

 esxcfg-route – Examine and configure routing 

 net-dvs -  

 Analyze Command Line Output to Identify vSS and vDS Configuration Details 

o Several commands exist to configure vSwitches. Some can be used for vDS 

 esxcfg-vswitch – Examine and configure virtual switches 

 esxcfg-vswif – Examine and configure service console ports 

 esxcfg-vmknic – Examine and configure VMkernel ports 

 esxcfg-route – Examine and configure routing 

 net-dvs –  
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Objective 2.2 – Configure and Maintain VLANs, PVLANs, and VLAN Settings 

 

Knowledge 

 Identify Types of VLANs and PVLANs 

o A VLAN (virtual lan) is a grouping of hosts that are able to communicate in the same 

broadcast domain even though they may not be physically plugged into the same network 

device 

o VLAN Trunking is the ability to pass multiple VLAN traffic (thus sharing) through a singular 

physical network connection  

o Private VLANs allow you to isolate traffic between virtual machines in the same isolated 

VLAN. These isolated PVLANs are referred to as the primary VLAN divided into secondary 

VLANs. PVLANs are only configurable in ESX on vDS. There are three types of secondary 

PVLANs 

 Promiscuous – VM’s are reachable by and can reach any machine in the same 

primary VLAN 

 Isolated – Vm’s can talk to no virtual machines except those in the promiscuous 

PVLAN 

 Community – VM’s can talk to each other and to the VMs in the promiscuous 

PVLAN, but not to any other VM 

Skills and Abilities 

 Determine Use Cases For and Configure VLAN Trunking 

o Use case for using VLAN trunking would be if you have multiple VLANs in place for logical 

separation or to isolate your VM traffic but you have a limited amount of physical uplink 

ports dedicated for your ESX hosts. For example: 
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o In the above example four port groups are created and are “tagged” with the required VLAN 

id’s that are used. Each of the vmnics is bonded together in a portchannel  (completed on 

the physical switch side) and is configured to “trunk” the various VLANs.  On the ESX switch 

side the NIC Teaming Load Balancing Policy will need to be set to Route based on IP hash 

o vDS Switches also can be enabled for VLAN Trunking which allows the switch to pass the 

tagged traffic to VMs. This requires that the VMs tag and untag the traffic 

 Determine Use Cases For and Configure PVLANs 

o Private VLANs provide additional security between virtual machines on the same subnet 

without exhausting VLAN number space. PVLANs are particularly useful on a DMZ where the 

server needs to be available to external connections and possibly internal connections, but 

rarely needs to communicate with other servers on the DMZ 

o Configuring a PVLAN is completed as follows 

1. In vCenter, go to Home -> Inventory -> Networking 

2. Click Edit Settings on the desired dvSwitch 

3. Choose the Private VLAN tab 

4. On the Primary tab, add the VLAN that is used outside the PVLAN domain. Enter a 

private LAN ID and/or choose one from the list 

5. On the Secondary Tab, create the PVLANs of the desired type (see definitions 

above). Enter a VLAN ID in the VLAN ID field 

6. Select the Type for the Secondary VLAN ID 

7. Click Ok 

o To set the PVLAN in the dvPortGroup 

1. Highlight dvPortGroup and click Edit Settings 

2. Click General -> VLAN -> Policies 

3. Using the dropdown, set the VLAN type to Private 

4. Select VLAN from the Private VLAN Entry dropdown 

(Sources: VMware KB 1010691 and KB 1010703) 

 Use Command Line Tools to Troubleshoot and Identify VLAN Configurations 

o Several commands exist to configure vSwitches. Some can be used for vDS 

 esxcfg-vswitch – Examine and configure virtual switches 
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Objective 2.3 – Deploy and Maintain Scalable Virtual Networking 

 

Knowledge 

 Identify VMware NIC Teaming Policies 

o VMware offers several policies under the NIC Teaming tab in the vSwitch properties 

 Load Balancing – Determines how outgoing traffic is distributed among the network 

adapters assigned to a vSwitch.  Four options for use: 

 Route based on the originating port ID – Choose an uplink based on the 

virtual port where the traffic entered the virtual switch 

 Route based on IP hash – Choose an uplink based on a hash of the source 

and destination IP addresses of each packet. For non-IP packets, whatever is 

at those offsets is used to compute the hash 

 Route based on source MAC hash – Choose an uplink based on a hash of the 

source ethernet 

 Use explicit failover order – Always use the highest order uplink from the list 

of Active adapters which passes failover detection criteria 

NOTE – IP-based teaming requires that the physical switch be configured with 

etherchannel. For all other options, etherchannel should be disabled 

 Network Failover Detection – Controls the link status and beacon probing. 

Beaconing is not supported with guest VLAN tagging. Two options for use: 

 Link Status Only – Relies solely on the link status that the network adapter 

provides. This option detects failures, such as cable pulls and physical switch 

power failures, but not configuration errors, such as a physical switch port 

being blocked by spanning tree or that is mis-configured to the wrong VLAN 

or cable pulls on the other side of a physical switch 

 Beacon Probing – Send out and listens for beacon probes on all NICs in the 

team and uses this information, in addition to link status, to determine link 

failure. This detects many of the failures previously mentioned that are not 

detected by link stats alone 

 Notify Switches – Select Yes or No to notify switches in the case of failover. If you 

select Yes, whenever a virtual NIC is connected to the vSwitch or whenever that 

virtual NIC’s traffic would be routed over a different physical network to update the 

lookup tables on physical switches. In almost all cases, this process is desirable for 

the lowest latency of failover occurrences and migrations with vMotion 

NOTE – Do not use this option when the virtual machines using the port group 

are using Microsoft Network Load Balancing in unicast mode. No such issue 

exists with NLB running in multicast mode 
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 Failback – Select Yes or No to disable or enabled failback. This option determines 

how a physical adapter is returned to active duty after recovering from a failure. If 

failback is set to Yes (default), the adapter is returned to active duty immediately 

upon recovery, displacing the standby adapter that took over its slot, if any. If 

failback is set to No, a failed adapter is left inactive even after recovery until another 

currently active adapter fails, requiring its replacement 

 Failover Order – Specify how to distribute the work load for uplinks, If you want to 

use some uplinks but reserve others for emergencies in case the uplinks in use fail, 

set this condition by moving them into different groups: 

 Active Uplinks – Continue to use the uplink when the network adapter 

connectivity is up and active 

 Standby Uplinks – Use this uplink if one of the active adapter’s connectivity 

is down 

 Unused Uplinks – Do not use this uplink 

(Sources: VMware ESX Configuration Guide) 

 Identify Common Network Protocols 

o HTTP – TCP port 80 

o HTTPS – TCP port 443 

o Telnet – TCP port 23 

o SSH – TCP port 22 

o SNMP – UDP port 161 

o DNS – TCP/UDP port 53 

Skills and Abilities 

 Understand the NIC Teaming Failover Types and Related Physical Network Settings 

o Review information under “Identify VMware NIC Teaming Policies” 

 Determine and Apply Failover Settings 

o Review information under “Identify VMware NIC Teaming Policies” 

 Configure Explicit Failover to Conform With VMware Best Practices 

o Set the Load Balancing to use “Explicit Failover” and adjust the needed vmnics in the 

Active/Standby/Unused Adapters section 

 Configure Port Groups to Properly Isolate Network Traffic 

o Within the Port Group properties make sure to specify a VLAN ID 
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Objective 2.4 – Administer vNetwork Distributed Switch Settings 

 

Knowledge 

 Explain Relationship Between vDS and Logical vSSes 

Skills and Abilities 

 Understand the Use of Command Line Tools to Configure Appropriate vDS Settings on an 

ESX/ESXi Host 

o The majority of configuration options for a vDS are completed via the GUI. However, 

there are a few command line arguments that can be used with the esxcvfg-vswitch 

command to modify/change a vDS: 

 To list and view all switches (vSS and vDS) on a host 

# esxcfg-vswitch –l 

 Add an uplink to a DVPort on a DVSwitch 

# esxcfg-vswitch –add-dvp-uplink=<vmnic> (or –P) 

 Delete an uplink from a  DVPort on a DVSwitch (Must specify DVPort ID) 

#esxcfg-vswitch –del-dvp-uplink=<vmnic> (or –Q) 

 Specify a DVPort Id for the operation 

#esxcfg-vswitch –dvp=<dvport> (or –V) 

 Determine Use Cases For and Apply Port Binding Settings 

o Port binding determines when and how a virtual machine’s virtual NIC is assigned to a 

virtual switch port. There are three port binding options that are configurable at the 

port group level 

 Static Binding – The default setting, a virtual switch port is permanently 

assigned to the VM’s NIC when the NIC is configured. No further VM 

connections are possible once all current virtual switch ports are assigned 

 Dynamic Port Binding – The virtual switch port is assigned to the VM’s NIC at the 

moment the virtual machine is powered on. This option allows for virtual switch 

port over commitment 

 Ephemeral Port Binding (None) – Resembles the behavior of standard virtual 

switch port assignment, the number of ports will be automatically set to 

unlimited. You can continue to connect virtual machines up to the maximum 

number of ports available for a distributed switch 

 Configure Live Port Moving 

o  

 Given a Set of Network Requirements, Identify the Appropriate Distributed Switch Technology 

to Use 

o Besides offering the vDS, VMware also allows for a 3rd party switch to be installed and 

used on ESX hosts (rides over the top of the vDS technology). Currently the vendor 



32 | P a g e  
 

supplied switch on the market is the Cisco Nexus 1000v. Listed below is various 

information about both 

 vDS and Cisco 1000v require Enterprise Plus licensing 

 1KV requires additional licensing from Cisco (per CPU) 

 vDS is managed via vSphere Gui/1KV is managed via Cisco IOS 

 1KV uses a virtual supervisor module and virtual Ethernet module 

  

 Use Command Line Tools to Troubleshoot and Identify Configuration Items From an Existing 

vDS 

o Again, using the esxcfg-vswitch command will allow some basic configuration of a vDS. 

Refer to previous objectives for further details 
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Section 3 – Deploy DRS Clusters and Manage Performance 

Objective 3.1 – Tune and Optimize vSphere Performance 

 

Knowledge 

 Identify Appropriate BIOS and Firmware Setting Requirements for Optimal ESX/ESXi Host 

Performance 

 Identify Appropriate ESX Driver Revisions Required for Optimal ESX/ESXi Host Performance 

 Recall Where to Locate Information Resources to Verify Compliance with VMware and Third Party 

Vendor Best Practices 

Skills and Abilities 

 Tune ESX/ESXi Host and Virtual Machine Memory Configurations 

 Tune ESX/ESXi Host and Virtual Machine Networking Configurations 

 Tune ESX/ESXi Host and Virtual Machine CPU Configurations 

 Tune ESX/ESXi Host and Virtual Machine Storage Configurations 

 Configure and Apply Advanced ESX/ESXi Host Attributes 

 Configure and Apply Advanced Virtual Machine Attributes 

 Tune and Optimize NUMA Controls 
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Objective 3.2 – Optimize Virtual Machine Resources 

 

Knowledge 

 Compare and Contrast Virtual and Physical Hardware Resources 

 Identify VMware Memory Management Techniques 

o VMware ESX/ESXi hosts utilize three techniques for managing VM memory 

 Transparent Page Sharing (TPS) – When multiple virtual machines are running, some 

of them may have identical sets of memory content. With page sharing, the 

hypervisor can reclaim the redundant copies and only keep one copy, which is 

shared by multiple virtual machines in the host physical memory. As a result, the 

total virtual machines host memory consumption is reduced and a higher level of 

memory over commitment is possible. 

 Ballooning – A “balloon driver” is loaded into the guest operating system (via 

VMware Tools) as a pseudo-device driver. It has no external interfaces to the guest 

operating system and communicates with the hypervisor through a private channel. 

The balloon driver polls the hypervisor to obtain a target balloon size. If the 

hypervisor needs to reclaim virtual machine memory, it sets a proper target balloon 

size for the balloon driver, making it “inflate” by allocating guest physical pages 

within the virtual machine. 

 Host Swapping – In the cases where ballooning and page sharing are not sufficient 

to reclaim memory, ESX employs hypervisor swapping to reclaim memory. To 

support this, when starting a virtual machine, the hypervisor creates a separate 

swap file for the virtual machine. Then, if necessary, the hypervisor can directly sap 

out guest physical memory to the swap file, which frees host physical memory for 

other virtual machines 

o These various memory techniques come into play when the memory level of a host comes 

under pressure. ESX maintains four host free memory states: high, soft, hard, and low, 

which are reflected by four thresholds: 6 percent, 4 percent, 2 percent, and 1 percent. The 

memory states can been seen using ESXTOP/RESXTOP 

(Source: VMware White Paper – Understanding Memory Resource Management in VMware ESX Server) 

 Identify VMware CPU Load Balancing Techniques 

o ESX Load-Balancing – Load balancing achieved by having a world migrate from a busy 

processor to an idle processor. Generally, the world migration improves the responsiveness 

of a system and its overall CPU utilization. On ESX the world migration may be initiated 

either by a pCPU, which becomes idle or a world, which becomes ready to be schedule. 

However, these migrations do incur cost. When a world migrates away from the source 

pCPU where it has run awhile and brought instructions and data, or the “working set”, into 

the on-chip cache, the world has to bring the working-set back into the cache of the 

destination pCPU, or “warm up” the cache. For workloads that benefit from the cache 
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performance, frequent migrations can be detrimental. To prevent cost migrations, the CPU 

schedule ensures that the migration only happens for the worlds that have not consume 

enough CPU resource in the past, so that the benefit of the migration outweighs the cost. 

o Load-Balancing on NUMA Systems – IN a NUMA (Non-Uniform Memory Access) system, 

there are multiple NUMA nodes that consist of a set of processors and the memory. The 

access to memory in the same node is “local” while the access to the other nodes is 

“remote”. Keeping the memory access local or maximizing the “memory-locality” improves 

performance. The NUMA load-balancer in ESX assigns a home node to a virtual machine. For 

the virtual machine, the memory is allocated from the home node. Since the virtual machine 

rarely migrates away from the home node, the memory access from the virtual machines is 

mostly local. Note that all vCPUs of the virtual machine are schedule within the home node. 

If a virtual machine’s home node is more heavily loaded than others, migrating to a less 

loaded node generally improves performance, although it suffers from remote memory 

accesses. The memory migration may also happen to increase the memory-locality. Note 

that the memory is moved gradually because copying memory has high overhead. 

o Load-Balancing on Hyperthreading Architectures – Hyperthreading enables concurrently 

executing instructions from tow hardware contexts in one processor. Although it may 

achieve higher performance from thread-level parallelism, the improvements is limited as 

the total computational resource is still capped by a single physical processor. Also the 

benefits is heavily workload dependent. It is clear that a whole idle processor, that has both 

hardware threads idle, provides more CPU resource than only one idle hardware thread 

with a busy sibling thread. Therefore, the ESX CPU scheduler makes sure the former is 

preferred as the destination of a migration. ESX provides an option that controls how 

hardware threads are to be utilized. 

(Source: VMware White Paper – VMware vSphere 4: The CPU Scheduler in VMware ESX 4) 

 Identify Pre-Requisites for Hot Add Features 

o vSphere 4 provides the ability to hot add vCPU’s or memory to supported OS running in a 

VM.  The pre-requisites for both are: 

 VMware Tools is installed 

 The virtual machine has a supported guest operating system 

 The virtual machine is using hardware version 7 or later 

 CPU/Memory hot plug is enabled on the Options tab of the Virtual Machine 

Properties dialog box 

o Procedure for CPU Hot Add 

1. In the vSphere Client inventory, right-click the virtual machine and select Edit 

Settings 

2. Click the Options tab and under Advanced, select Memory/CPU Hotplug 

3. Change the CPU Hot Plug setting 

a) Disable CPU hot plug for this virtual machine 

b) Enable CPU hot add only for this virtual machine 
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c) Enable CPU hot add and remove for this virtual machine 

d) Click OK to save your changes and close the dialog box 

o Procedure for Memory Hot Add 

1. In the vSphere Client inventory, right-click the virtual machine and select Edit 

Settings 

2. Click the Options tab and under Advanced, select Memory/CPU Hotplug 

3. Enable or disable memory hot add 

a) Enable memory hot add for this virtual machine 

b) Disable memory hot add for this virtual machine 

4. Click OK to save your changes and close the dialog box 

(Source: VMware ESX Configuration Guide) 

 

Skills and Abilities 

 Calculate Available Resources 

o Utilize ESXTOP/RESXTOP to view host utilization 

o Utilize Performance graphs in the VC client 

o Utilize Perfmon in Windows based VM’s 

 Properly Size a Virtual Machine Based on Application Workload 

o Size memory for VM’s based on application requirements and usage 

o Size CPU’s for VM’s based on application requirements and if it can support a multiple CPU’s 

 Configure Large Memory Pages 

o Most modern processors support memory pages of large sizes, called “large pages” or 

“super pages”. In addition to the usual 4KB memory pages, processors support the larger 

page size of 2MB. The large translation lookaside buffer (TLB) covers a larger memory range 

than the small TBL, thus the use of large pages can possibly reduce TLB misses. As a result, 

many applications can benefit from large pages. Large pages improve the performance of 

many applications, but misuse of large pages may also hurt performance in some situations. 

The potential for performance degradation is a result of the fact that the number of large 

TLB entries is usually smaller then the number of small TLB entries. If the working set of an 

application is scattered over a wide range of address space, the application is likely to 

experience thrashing of a relatively small number of large TLB entries. This thrashing may 

result in worse overall performance with higher TLB miss rates. 

 

By default ESX assigns these 2MB machine memory pages to guest operating systems that 

request them, giving the guest operating system the full advantage of using large pages. The 

use of large pages results in reduced memory management overhead and can therefore 

increase hypervisor performance. If an operating system or application can benefit from 

large pages on a native system, that operating system or application can potentially achieve 
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a similar performance improvement on a virtual machine backed with 2MB machine 

memory pages. 

o Enabling Large Page Support in Window Server 2003 

1. Choose Start -> Control Panel -> Administrative Tools -> Local Security Policy 

2. In the left pane of the Local Security Settings window, expand Local Policies and 

choose User Rights Assignment 

3. In the right pane of the Local Security Settings window, choose Lock Pages In 

memory and choose Action -> Properties. The local Security Setting dialog box 

opens 

4. In the Local Security Setting dialog box, click Add User or Group 

5. Enter the appropriate user name, then click OK to close the Select Users or Groups 

dialog box 

6. Click OK to close the Local Security Policy Setting dialog box. The Local Security 

Settings window shows the user assigned to the policy 

7. You need to log out, then log back in or reboot to free memory. Now, applications 

running as this user can access large pages 

 Understand Appropriate Use Cases for CPU Affinity 

o By specifying a CPU affinity setting for each virtual machine, you can restrict the assignment 

of virtual machines to a subset of the available processors in multiprocessor systems. By 

using this feature, you can assign each virtual machine to processors in the specified affinity 

set. The CPU affinity seeing for a virtual machine applies to all of the virtual CPUs associated 

with the virtual machine and to all other threads (also known as “worlds) associated with 

the virtual machine. Such virtual machine threads perform processing required for 

emulating mouse, keyboard, screen, CD-ROM, and miscellaneous legacy devices. For the 

best performance, when you use manual affinity settings, VMware recommends that you 

include at least on additional physical CPU in the affinity setting to allow at least one of the 

virtual machine’s threads to be scheduled at the same time as its virtual CPUs. Examples of 

this include a uniprocessor virtual machine with affinity to at least two CPUs or a two-way 

SMP virtual machine with affinity to at least three CPUs. 

o Potential Issues with CPU Affinity 

 For multiprocessor systems, ESX/ESXi systems perform automatic load balancing. 

Avoid manual specification of virtual machine affinity to improve the scheduler’s 

ability to balance load across processors 

 Affinity can interfere with the ESX/ESXi host’s ability to meet the reservation and 

shares specified for a virtual machine 

 Because CPU admission control does not consider affinity, a virtual machine with 

manual affinity settings might not always receive its full reservation. Virtual 

machines that do not have manual affinity settings are not adversely affected by 

virtual machines with manual affinity settings 

 When you move a virtual machine from on host to another, affinity might no longer 

apply because the new host might have a different number of processors 
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 The NUMA scheduler might not be able to manage a virtual machines that is already 

assigned to certain processors using affinity 

 Affinity can affect an ESX/ESXi host’s ability to schedule virtual machines on 

multicore or hyperthreaded processors to take full advantage of resources shared 

on such processors 
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Objective 3.3 – Implement and Maintain Complex DRS Solutions 

 

Knowledge 

 Explain DRS Affinity and Anti-affinity Rules 

o Affinity rules allow you to control the placement of virtual machines on hosts within a 

cluster. There are two types of affinity rules: 

 VM-Host Affinity – Specifies whether or not the members of a selected virtual 

machine DRS group can run on the members of a specific host DRS group. A VM-

Host affinity rule specified an affinity relationship between a group of virtual 

machines and a group of hosts. There are ‘required’ rules (designated by “must”) 

and ‘preferential’ rules (designated by “should”). Because VM-Host affinity rules are 

cluster-based, the virtual machines and hosts that are included in a rule must all 

reside in the same cluster. 

 VM-VM Affinity – Specifies whether selected individual virtual machines should run 

on the same host or be kept on separate hosts. This type of rule is used to create 

affinity or anti-affinity between individual virtual machines that you select. When an 

affinity rule is created, DRS tires to keep the specified virtual machines together on 

the same host. With an anti-affinity rule, DRS tries to keep the specified virtual 

machines apart. 

(Source: VMware vSphere Resource Management Guide) 

 Identify Required Hardware Components to Support DPM 

o VMware’s Distributed Power Management (DPM) is a feature that allows a DRS cluster to 

reduce its power consumption by powering hosts on and off based on cluster resource 

utilization. VMware DPM can use one of three power management protocols: 

 Intelligent Platform Management Interface (IPMI) 

 Hewllet-Packard Integrated Lights-Out (iLO) 

 Wake-On LAN (WOL) – Must be supported on the vMotion interface 

(Source: VMware vSphere Resource Management Guide) 

 Identify EVC Requirements, Baselines, and Components 

o Enhanced vMotion Compatibility (EVC) – You can use EVC to help ensure vMotion 

compatibility for hosts in a cluster. EVC ensures that all hosts in a cluster present the same 

CPU feature set to virtual machines, even if the actual CPUs on the hosts differ. This 

prevents migrations with vMotion from failing due to incompatible CPUs. When you 

configure EVC, you configure all host processors in the cluster to present the feature set of a 

baseline processor. This baseline feature set is called the EVC mode. Hosts in an EVC cluster 

must meet certain requirements: 
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 All virtual machines in the cluster that are running on hosts with a feature set 

greater than the EVC mode you intend to enable must be powered off or migrated 

out of the cluster before EVC is enabled 

 All hosts in the cluster must have CPUs from a single vendor, either AMD or Intel 

 All hosts in the cluster must be running ESX/ESXi 3.5 Update 2 or later 

 All hosts in the cluster must be connected to the vCenter Server System 

 All hosts in the cluster must have advanced CPU features, such as hardware 

virtualization support (AMD-V or Intel VT) and AMD No eXecute (NX) or Intel 

eXecute Disable (XD), enabled in the BIOS if they are available 

 All hosts in the cluster should be configured for vMotion 

 All host in the cluster must have supported CPUs for the EVC mode you want to 

enable 

 Understand the DRS Slot-size Algorithm and its Impact on Migration Recommendations 

o Slot size is comprised of two components, CPU and memory 

 VMware HA calculates the CPU component by obtaining the CPU reservation of 

each powered-on virtual machine and select the largest value. If you have not 

specified a CPU reservation for a virtual machine, it is assigned a default value of 

256 MHz. You can change this value by using the das.slotcpuinmhz advanced 

attribute. 

 VMware HA calculates the memory component by obtaining the memory 

reservation, plus memory overhead, of each powered-on virtual machine and select 

the largest value. There is no default value for the memory reservation. 



41 | P a g e  
 

 

Skill and Abilities 

 Properly Configure BIOS and Management Settings to Support DPM 

o If using IPMI or iLO you must configure the BMC (Baseboard Management Controller). With 

IPMI, you must also ensure that the BMC LAN channel is configured to be always available 

and to allow operator-privileged commands. When you enable “IPMI over LAN” you must 

configure this in the BIOS and specify a particular IPI account 

o If using Wake-on-LAN (WOL) the NIC used for vMotion must be supported. The switch port 

for that NIC should be set to auto negotiate the link speed 
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 Test DPM to Verify Proper Configuration 

1. Within the vCenter Client select a host a click the Summary tab 

2. Click the Enter Standby Mode command, this action powers down the host 

3. Try to bring the host out of standby mode by clicking the Power On command on the host’s 

Summary tab 

4. Observe whether or not the host successfully powers back on 

5. For any host that fails to exit standby mode successfully, select the host in the cluster 

Settings dialog box’s Host Options page and change its Power Management  setting to 

Disabled 

 Configure Appropriate DPM Threshold to Meet Business Requirements 

o VMware DPM assigned priorities that range from priority-one recommendations to priority-

five recommendations. These priority ratings are based on the amount of over or under 

utilization found in the DRS cluster and the improvement that is expected from the intended 

host power state change. A priority-one recommendation is mandatory, while a priority-five 

recommendation brings only slight improvement 

o The threshold is configured under Power Management in the cluster’s Settings dialog box. 

Each level you move the VMware DPM Threshold slider to the right allows the inclusion of 

one or more lower level of priority in the set of recommendations that are executed 

automatically or appear as recommendations to be manually executed. 

o You can override the DPM settings of a host by selecting the Host Options page of the 

cluster’s Settings dialog box and clicking its Power Management settings. You can change 

this setting to the following options: 

1. Disabled 

2. Manual 

3. Automatic 

 Configure EVC Using Appropriate Baseline 

o Creating a New EVC Cluster 

1. Ensure that hosts meet the requirements outlined in section Identify EVC 

Requirements, Baselines, and Components 

2. Create an empty cluster, and enable EVC 

 Select the CPU vendor and EVC mode appropriate for the hosts you intend 

to add to the cluster (CPU Baseline) 

3. Select a host to move into the cluster 

4. If the host feature set is greater than the EVC mode that you have enabled for the 

EVC cluster, ensure that the cluster has no powered on virtual machines 

 Power off all the virtual machines on the host 

 Migrate the host’s virtual machines to another host using vMotion 

5. Move the host into the cluster 

 You can power on the virtual machines on the host, or migrate virtual 

machines into the cluster with vMotion, if the virtual machines meet CPU 

compatibility requirements for the cluster’s EVC Mode. Virtual machines 
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running on hosts with more features than the EVC mode must be powered 

off before migration into the cluster 

6. Repeat Step 4 and Step 5 for each additional host that you want to move into the 

cluster 

 Configure the EVC Mode on an Existing DRS Cluster 

o Enable EVC on an Existing Cluster 

1. Ensure that hosts meet the requirements outlined in section Identify EVC 

Requirements, Baselines, and Components 

2. If virtual machines are running on hosts that have feature sets greater than the EVC 

mode you intend to enable, ensure that the cluster has no powered on virtual 

machines 

 Power off all the virtual machines on the hosts with feature sets greater 

than the EVC mode 

 Migrate the cluster’s virtual machines to another host using vMotion 

3. Ensure that the cluster contains hosts with CPUs from only one vendor 

4. Edit the cluster settings and enabled EVC 

 Select the CPU vendor and feature set appropriate for the hosts in the 

cluster 

5. If you powered off or migrated virtual machines out of the cluster, power on the 

virtual machines in the cluster, or migrate virtual machines into the cluster 

 Any virtual machines running with a larger feature set than the EVC mode 

you enabled for the cluster must be powered off before they can be moved 

back into the cluster 

o Change the EVC Mode for a Cluster – If all the hosts in a cluster are compatible with the new 

mode, you can change the EVC mode of an existing EVC cluster. To raise the EVC mode from 

a CPU baseline with fewer features to one with more features, you do not need to turn off 

any running virtual machines in the cluster. The virtual machines will not have access to the 

new features until they are powered off and powered back on. To lower the EVC mode you 

must power off any virtual machines in the cluster that are running at a higher EVC mode 

than the one you intend to enable, and power them back on after the new mode has been 

enabled. 

1. Display the cluster in the inventory 

2. Right click the cluster and select Edit Settings 

3. In the left pane, select VMware EVC 

4. To edit the EVC settings click Change 

5. From the VMware EVC Mode drop down menu, select the baseline CPU feature set 

you want to enable for the cluster 

6. Click OK to close the EVC Mode dialog box, and click OK to close the cluster settings 

dialog box 

 Create DRS and DPM Alarms 
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o The most serious potential error you face when using VMware DPM is the failure of a host 

to exit standby mode when its capacity is needed by the DRS cluster. You can monitor for 

instances when this error occurs by using the preconfigured Exit Standby Error alarm. Other 

alarms can be created with the following event types: 

1. Entering Standby Mode (about to power off host) 

2. Successfully Entered Standby Mode (host power off succeeded) 

3. Exiting Standby Mode (about to power on the host) 

4. Successfully Exited Standby Mode (power on succeeded) 

 Configure Applicable Power Management Settings for ESX Hosts 

o ESX/ESXi provides up to four power management policies. You choose a power management 

policy depending on a host’s hardware characteristics and BIOS support, which allows you to 

configure servers for specific levels of power efficiency and performance. To improve CPU 

power efficiency, ESX/ESXi can take advantage of performance states (also known as P-

states) to dynamically adjust CPU frequency to match the demand of running virtual 

machines. When a CPU runs at a lower frequency, it can also run at a lower voltage, which 

saves power. When a CPU is idle, ESX/ESXi can take advantage of power states (also known 

as C-states) and put the CPU in a deep sleep state. As a result the CPU consumes as little 

power as possible and can quickly resume from sleep when necessary. The Power 

Management Policies are: 

1. Not Supported – The host does not support any power management features or 

power management is not enabled in the BIOS 

2. High Performance (Default) – Vmkernel detected certain power management 

features, but will not use them unless the BIOs requests them for power capping or 

thermal events 

3. Balanced Performance – Vmkernel is using all available power management features 

to reduce host energy consumption without compromising performance 

4. Low Power – Vmkernel aggressively uses available power management features to 

reduce host energy consumption at the risk of lower performance 

5. Custom – Vmkernel implements specific user-defined power management features 

based on the values of advanced configuration parameters. The parameters are set 

in the vSphere Client Advanced Settings dialog box 

o ESX/ESXi supports the Enhanced Intel SpeedStep and Enhanced AMD Power Now! CPU 

power management technologies. These must be enabled in the system BIOS. Also 

advanced settings need to be changed on a host: 

1. In vSphere Client select a host and click the Configuration tab 

2. Select Advanced Settings under Software 

3. Select Power in the left hand column 

4. Change the Power.CpuPolicy parameter from “static” to “dynamic” 

o Select a CPU Power Management Policy 

1. In the vSphere Client inventory panel, select a host and click the Configuration tab 

2. Under Hardware, select Power Management and select Properties 

3. Select a power management policy for the host and click OK 
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Note – The policy selection is saved in the host configuration and can be used again at 

boot time. You can change it at any time, and it does not require a server reboot 

 Properly Size Virtual Machines and Clusters for Optimal DRS Efficiency 

 Properly Apply Virtual Machine Automation Levels Based Upon Application Requirements 

o Setting a custom automation level for a virtual machine is possible if you want to over-ride 

the cluster’s default automation level. To do so 

1. Select the cluster in the vSphere Client inventory 

2. Right-click and select Edit Settings 

3. In the Cluster Settings dialog box, under VMware DRS select Virtual Machine 

Options 

4. Select the Enabled Individual Virtual Machine Automation Levels check box 

5. Select an individual virtual machine, or select multiple virtual machines 

6. Right-click and select an automation mode 

7. Click OK 
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Objective 3.4 – Perform Capacity Planning in a vSphere Environment 

 

Knowledge 

 Understand the DRS Slot Size Algorithm and its Impact on Migration Recommendations 

o See section 3.3 above. 

 Identify Tools Needed for Monitoring Capacity Planning 

o Esxtop/resxtop 

o vscsiStats 

o vSphere Client Performance Charts 

 Identify Performance Metrics Related to Resource Contention and Saturation 

o CPU Metrics and Thresholds (Guest VM, esxtop/resxtop) 

 %RDY – 10 – Over provisioning of vCPUS, excessive usage of vSMP or a limit has 

been set 

 %CSTP – 3 – Excessive usage of vSMP. Decrease amount of vCPUs for this particular 

VM. This should lead to increased scheduling opportunities 

 %MLMTD – 0 – If larger than 0 the worlds is being throttled. Possible limit on CPU 

 %SWPWT – 5 – VM waiting on swapped pages to be read from disk. Possible 

Memory over commitment 

o Memory Metrics and Thresholds (Guest VM, esxtop/resxtop) 

 MCTLSZ – 1 – If larger than 0 host is forcing VMs to inflate balloon driver to reclaim 

memory as host is overcommitted 

 SWCUR – 1 – If larger than 0 hosts has swapped memory pages in the past. Possible 

memory over commitment 

 SWR/s – If larger than 0 host is actively reading from swap (vswp). Possible cause 

memory over commitment 

 N%L – 80 – If less than 80 VM experiences poor NUMA locality. 

o Network Metrics and Thresholds (Guest VM, esxtop/resxtop) 

 %DRPTX – 1 - Dropped packages transmitted, hardware overworked. Possible cause: 

very high network utilization 

 %DRPRX - 1 - Dropped packages received, hardware overworked. Possible cause: 

very high network utilization 

o Disk Metrics and Thresholds (Host, esxtop/resxtop) 

 GAVG - 25 - Look at “DAVG” and “KAVG” as the sum of both is GAVG. 

 DAVG - 25 - Disk latency most likely to be caused by array. 

 KAVG - 2 - Disk latency caused by the VMkernel, high KAVG usually means queuing. 

Check “QUED”. 

 QUED - 1 - Queue maxed out. Possibly queue depth set to low. Check with array 

vendor for optimal queue depth value. 
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 ABRTS/s - 1 - Aborts issued by guest (VM) because storage is not responding. For 

Windows VMs this happens after 60 seconds by default. Can be caused for instance 

when paths failed or array is not accepting any IO for whatever reason. 

 RESETS/s - 1 - The number of commands reset per second. 

(Source: Yellow-Bricks.com ESXTOP) 

Skills and Abilities 

 Predict When Additional ESX/ESXi Host, Network, or Storage Resources will be Required by 

Observing and Existing Environment 

o Using available resources and tools available to you to monitor your ESX/ESXi hosts 

 vSphere Performance Charts 

 esxtop/resxtop 

 Determine When to Expand or Contract Provisioned Virtual Machine Resources Based Upon 

Observed Virtual Machine Utilization 

o Again, using available resources and tools available to you to monitor your VM’s 

 vSphere Performance Charts 

 esxtop/resxtop 

 vscsiStats 

 Perfmon for Windows based VM’s (VM Memory and VM Processor counters) 

 Interpret Performance Metrics From vCenter to Properly Size the Environment 

o Use vSphere Performance Charts 

o Read and become familiar with VMware document Overview Performance Charts Help 
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Objective 3.5 – Utilize Advanced vSphere Performance Monitoring Tools 

 

Knowledge 

 Identify Hot Keys and Fields Used With resxtop/esxtop 

Command Line Options (esxtop/resxtop) 

--server (resxtop only) The name of the remote server host to connect to 

--vihost (resxtop only) The name of vCenter Server to connect to 

--portnumber (resxtop only) The port number to connect to on the remote server (default 443) 

--username The user name to be authenticated when connecting to the remote host 

--help Displays help menu 

-v Prints version 

-b Enables batch mode 

-s Enables secure mode 

-a Shows all statistics 

-c filename Sets the esxtop configuration file, which by default is .esxtop4rc 

-d Sets the delay between updates in seconds 

-n Runs esxtop for only n iterations 
 

Interactive Mode Single-Key Commands 

h or ? Displays a help menu for the current panel 
Space bar Immediately updates the current panel 

^L Erases and redraws the current panel 

f or F Display a pane for adding or removing statistics columns 
o or O Display a pane for changing the order of statistics columns 

# Prompts you for the number of statistics rows to display 

s Prompts you for the delay between updates in  seconds 
W Write the current setup to an esxtop/resxtop configuration file 

q Quit interactive mode 

c Switch to the CPU resource utilization panel 
p Switch to the CPU Power utilization panel 

m Switch to the memory resource utilization panel 

d Switch to the storage (disk) adapter resource utilization panel 

u Switch to storage (disk) device resource utilization screen 
v Switch to storage (disk) virtual machine resource utilization screen 

n Switch to the network resource utilization panel 

i Switch to the interrupt panel 
y Switch to power management panel 
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 Identify Fields Used With vscsiStats 

o This tool controls vscsi data collection for virtual machine disk disk I/O workload 

characterization. Users can start and stop online data collection for particular VMs as well as 

print out online histogram data. Command traces cal also be collected and printed. The 

command is located in /user/lib/vmware/bin. 

o The following histogram related options are available 

Command Switch Description 

-h, --help Prints help message 

-l, --list Will list the available virtual machines and 
their virtual disks 

-r, --reset Weill reset the stats 
-s, --start Will start vscsiStats collection; exclusive of –x 

-x, --stop Will stop vscsiStats collection; exclusive of –s 

-w <worldgroup id>, --worldgroupid Specifies a worldID to use for this operation 
-i <handle id>, --handleid Specifies a vscsi handleID to use for this 

operation requires the –w option 
-p <histoType>, --printhistos Will print out the current histograms for the 

specified histogram type. May be used in 
conjunction with –w and –i. histoType must 
be one and only one of: all, ioLength, 
seekDistance, outstandingIOs, latency, 
interarrival 

-c, --csv Will use comma as delimiter in conjunction 
with -p 

o The following command traced related options are available 

Command Switch Description 

-t, --tracecmds Will start scsi cmd traces; in conjunction 
with –s 

-e <trace file name>, --traceprettyprint Reads in a vscsi cmd trace from the give 
filename and sends a CSV formatted output 
to stdout; exclusive of all other options 

NOTE – The –t option consumes significant system resources so enabling it indefinitely is not 

advisable. Try to limit the #virtual disk for which cmd tracing is enabled at any give time by using 

–worldgroupid and/or –hnadleid options. Trace contains NO customer sensitive data. Only 

information recorded is 

 Serialnumber 

 I/O block size 

 Number of scatter-gather elements 

 Command type 

 Block number 

 Timestamp 

If successfully started, log channel id(s) will be printed out. To store the command trace in a file 

for later processing, invoke: 
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#logchannellogger <log_channel_id> <binary_trace_file> 

Skills and Abilities 

 Configure /resxtop Custom Profiles 

o By default when running esxtop/resxtop it uses the .esxtop41rc  file to load the display 

configuration. You can customize the esxtop/resxtop display to show the columns you 

specify and organized by creating your own configuration file, and then using that file when 

launching esxtop/resxtop 

 Launch esxtop/resxtop in Interactive mode 

 Customize the various screens to your liking 

 Press capital W to specify a configuration file name and location 

 Moving forward each time esxtop/resxtop is started use the –c <filename> 

command to esxtop/resxtop with your customizations  

 Determine Uses Cases for and Apply esxtop/resxtop Interactive, Batch and Replay Modes 

o Interactive mode allows you to monitor and watch and ESX/ESXi host in real time. It does 

not allow for the capture or saving of data 

o Batch Mode allows you to collect and save resource utilization statistics in a file: 

 Prepare for Batch Mode 

1. Run esxtop/resxtop in interactive mode 

2. In each of the panels, select the columns you want 

3. Save this configuration to a file using the W interactive command 

 Uses esxtop/resxtop in Batch Mode 

1. Start esxtop/resxtop to redirect the output to a file 

# esxtop –b > my_file.csv 

File name must have a .csv extension 

2. Process statistics collect in batch mode using tools such as MS Excel or 

Windows Perfmon 

 In batch mode,  esxtop/resxtop does not accept interactive commands. In batch 

mode, the utility runs until it produces the number of iterations requested or until 

you end the process by pressing Ctrl+c 

o Replay Mode replays resource utilization statistics collected using vm-support. In replay 

mode esxtop/resxtop accepts the same set of interactive commands as in interactive mode 

and runs until no more snapshots are collected by vm-support to be read or until the 

requested number of iterations are completed. 

 Prepare for Replay Mode 

1.  Run vm-support in snapshot mode 

# vm-support –S –d <duration> -I <interval> 

2. Unzip and untar the resulting tar file so that esxtop/resxtop can use it in 

replay mode 

 Use esxtop/resxtop in Replay Mode 
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1. To activate replay mode, enter the following command 

# esxtop –R <vm-support_dir_path 

 Use vsciStats to Gather Storage Performance Data 

 Use esxtop/resxtop to Collect Performance Data 

 Given exstop/resxtop Output, Identify Relative Performance Data for Capacity Planning Purposes 
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Section 4 – Manage Business Continuity and Protect Data 

Objective 4.1 – Implement and Maintain Complex VMware HA Solutions 

 

Knowledge 

 Identify the Three Admission Control Policies for HA 

o vCenter Server uses admission control to ensure that sufficient resources are available in a 

cluster to provide failover protection and to ensure that virtual machine resource 

reservations are respected. Three types of admission control are available: 

 Host – Ensures that a host has sufficient resources to satisfy the reservations of all 

virtual machines running on it 

 Resource Pool – Ensures that a resource pool has  sufficient resources to satisfy the 

reservations, shares, and limits of all virtual machines associated with it 

 VMware HA – Ensures that sufficient resources in the cluster are reserved for virtual 

machine recovery in the event of host failure 

 Identify Heartbeat Options and Dependencies 

o ESX/ESXi uses agents that communicate with each other and monitor the liveness of the 

hosts in the cluster. This communication is done through the exchange of heartbeats, by 

default, every second. If a 15 second period elapses without the receipt of heartbeats from 

a host, and the host cannot be pinged, it is declared as failed. In the event of a host failure, 

the virtual machines running on that host are failed over, that is, restarted on alternate 

hosts. 

 

When the isolated host’s network connection is not restored for the 15 seconds or longer, 

the other hosts in the cluster treat the isolated hosts as failed and attempt to fail over its 

virtual machines. Howe ever, when an isolated host retains access to the shared storage it 

also retains the disk lock on virtual machine files. To avoid potential data corruption, VMFS 

disk locking prevents simultaneous write operations to the virtual machine disk files and 

attempts to fail over the isolated host’s virtual machines fail. By default, the isolate host 

shuts down its virtual machines, but you can you change the host isolation response. 

Skills and Abilities 

 Calculate Host Failure Requirements 

 Configure Customized Isolation Response Settings 

o VMware HA has three options to handle host isolation response 

 Shut Down (Default) –Requires VMware Tools to be installed 

 Power Off 

 Leave Powered On 

Note – You can override the cluster setting and apply a custom policy to a VM 

o Several Advanced Settings can be configured for VMware HA 
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 das.isolationaddress[x] – Sets the address to ping to determine if a host is isolated 

from the network. This address is pinged only when heartbeats are not received 

from any other host in the cluster. If not specified, the default gateway of the 

management network is used. You can specify multiple isolation addresses (up to 

10) for the cluster 

 das.usedefaultisolationaddress – By default VMware HA uses the default gateway of 

the console network as an isolation address. This attribute specifies whether or not 

this default is used (true|false) 

 das.failuredetectiontime – Changes the default detection time for host monitoring. 

The default is 15000 milliseconds (15 seconds). This is the time period, when a host 

has received no heartbeats from another host, that it waits before declaring that 

host as failed 

 das.failuredetectioninterval – Changes the heartbeat interval among VMware HA 

hosts. By default this occurs every 1000 milliseconds (1 second) 

 das.isolationshutdowntimeout – The period of time the system waits for a virtual 

machine to shut down before powering it off. This only applies if the host’s isolation 

response is Shut down VM. Default value is 300 seconds 

 das.maxvmrestartcount – Configure the maximum amount of retries for a restart of 

a virtual machine. Select the value “0” for no restarts, -I for indefinite. The default is 

5 

 Configure HA Redundancy in a Mixed ESX/ESXi Environment 

o You can implement network redundancy at the NIC level with NIC teaming, or at the 

management network level. In most implementations, NIC teaming provides sufficient 

redundancy, but you can use or add management network redundancy if required. 

Redundant management networking allows the reliable detection of failures and prevents 

isolation conditions from occurring, because heartbeats can be sent over multiple networks. 

 

To identify which network operations might disrupt the functioning of VMware HA, you 

should be aware of which management networks are being used for heart beating and other 

VMware HA communications. 

 On ESX hosts in the cluster, VMware HA communications travel over all networks 

that are designated as service console networks. VMkernel networks are not used 

by these hosts for VMware HA communications. 

 On ESXi hosts in the cluster, VMware HA communications, by default, travel over 

VMkernel networks, except those marked for use with vMotion. If there is only one 

VMkernel network, VMware HA shares it with vMotion, if necessary. With ESXi 4.0 

and later, you must also explicitly enable the Management Network checkbox for 

VMware HA to use this network 

 Configure HA Related Alarms and Monitor an HA Cluster 

o Several alarm types are available to configure through vCenter. Look through Clusters, 

Datacenters, and Hosts with the selection of “Monitor for specific events” to see listings of 

possible alarm options. 
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 Create a Custom Slot Size Configuration 

o Slot size is comprised of two components, CPU and memory 

 VMware HA calculates the CPU component by obtaining the CPU reservation of 

each powered on virtual machine and selecting the largest value. If you have not 

specified CPU reservation for a virtual machine, it is assigned a default value of 256 

MHz. 

 VMware HA calculates the memory component by obtaining the memory 

reservation, plus memory overhead, of each powered on virtual machine and 

selecting the largest value. There is no default value for the memory reservation 

o You can customize the HA slot sizes my using the following two Advanced Settings 

 das.slotmeminmb – Defines the maximum bound on the memory slot size. If this 

option is used, the slot size is the smaller of this value or the maximum memory 

reservation plus memory overhead of any powered on virtual machine in the cluster 

 das.slotcpuinmhz – Defines the maximum bound on the CPU slot size. If this option 

is used, the slot size is the smaller of this value or the maximum CPU reservation of 

any powered on virtual machine in the cluster 

 Understand Interactions Between DRS and HA 

o In a cluster where both DRS and HA are enabled  this will provide the ability to recover from 

a failed host as well as balance the load across the remaining nodes in the cluster. If a node 

fails HA is responsible for restarting the failed guest VM’s on the remaining nodes in the 

cluster. After the VM’s have been placed and powered on it is up to DRS to properly balance 

out the resources across the cluster. 

 Create an HA Solution that Ensures Primary Node Distribution Across Sites 

o The first five hosts added to a HA cluster are designated as primary hosts, and all 

subsequent hosts are designated as secondary hosts. The primary hosts maintain and 

replicate all cluster state and are used to initiate failover actions. If a primary host is 

removed from the cluster, VMware HA promotes another (secondary) host to primary 

status. One of the primary hosts is also designated as the active primary host. Its 

responsibilities include: 

 Deciding where to restart virtual machines 

 Keeping track of failed restart attempts 

 Determining when it is appropriate to keep trying to restart a virtual machine 

o As there is not a way to view in the vSphere client which nodes are primary and which are 

secondary, use the below command from the Service Console to display the information 

# cat /var/log/vmware/aam/aam_config_util_listnodes.log 

o To properly design an HA solution, your design needs to incorporate solutions that ensures 

that at least one primary host is always available. For rack mount servers this might entail 

physical placement in different locations. When dealing with blade servers be sure to use 

multiple chassis and spread primary nodes across them. 

 Analyze vSphere Environment to Determine Appropriate HA Admission Control Policy 

o Three Admission Control Policies are available to use with VMware HA 
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 Host Failures Cluster Tolerates – The VMware HA ensures that a specified number of 

hosts can fail and sufficient resource remain in the cluster to fail over all the virtual 

machines from those hosts. VMware HA performs admission control in the following 

way: 

1. Calculates the slot size 

2. Determines how many slots each host in the cluster can hold 

3. Determines the Current Failover Capacity of the cluster 

4. Determines whether the Current Failover Capacity is less than the 

Configured Failover Capacity 

 Percentage of Cluster Resources Reserved – VMware HA ensures that a specified 

percentage of aggregate cluster resources is reserved for failover. Admission control 

is handled the following way: 

1. Calculates the total resource requirements for all powered on virtual 

machines in the cluster 

2. Calculates the total host resources available for virtual machines 

3. Calculates the Current CPU Failover Capacity and Current Memory Failover 

Capacity for the cluster 

4. Determines if either the Current CPU Failover Capacity or Current Memory 

Failover Capacity is less than the Configured Failover Capacity (provided by 

the user) 

Current Failover Capacity is calculated with the following formula: 

((Total Host Resource – Total Resource Requirements)/ Total Host Resource) 

 

Example – 30GHz of Total Host Resource and 8GHz of Total Resource Requirement 

((30GHz – 8Ghz)/30GHz) = 73% CPU Failover Capacity 

 Specify a Failover Host – VMware HA attempts to restart its virtual machines on a 

specified failover host. If this is not possible, for example the failover host itself has 

failed or it has insufficient resources, then VMware HA attempts to restart those 

virtual machines on other hosts in the cluster. To ensure that spare capacity is 

available on the failover host you are prevent from powering on virtual machines or 

using  vMotion to migrate virtual machines to the failover hosts. Also, DRS does not 

use the failover host for load balancing. 

 Analyze Performance Metrics to Calculate Host Failure Requirements 

 Analyze Virtual Machine Workload to Determine Optimum Slot Size 

o By default HA slot sizing is based on the highest CPU reservation of any given VM and the 

highest memory reservation of any given VM. Using this information the proper sizing of 

your VM’s becomes critical as those metrics can skew the number of slot sizes available in 

your cluster, especially if you may have only one or two large built VM’s compared to the 

remainder. Using vSphere Performance Charts monitor VM’s activity and adjust accordingly 

 Analyze HA Cluster Capacity to Determine Optimum Cluster Size 
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Objective 4.2 – Deploy and Test VMware FT 

 

Knowledge 

 Identify VMware FT Hardware Requirements 

o FT-compatible processor (use VMware SiteSurvey tool to verify) 

o Shared Storage (FC, iSCSI, NAS) 

o Gigabit Interface for FT logging traffic (10GB recommended) 

o Hardware Virtualization enabled in system BIOS 

 Identify VMware FT Compatibility Requirements 

o Host Compatibility Requirements 

 Must be licensed for VMware Fault Tolerance 

 Hosts must be running the same build of ESX or ESXi (Recommended not to use a 

mix cluster with VMware FT 

o VM Compatibility Requirements 

 Single vCPU only 

 All VMDK’s that are “thick” formatted 

 Must be running a supported OS (see KB 1008027 for list) 

o Unsupported vSphere Features with FT 

 Snapshots 

 Storage vMotion 

 Linked Clones 

 VMware Consolidated Backup 

 SMP Virtual Machines 

 Physical RDM’s 

 N_Port ID Virtualization (NPIV) 

 NIC passthrough 

 Hot-plugging devices 

(Sources: VMware vSphere Availability Guide, VMware Fault Tolerance Recommendations and Considerations on VMware 

vSphere 4) 

Skills and Abilities 

 Modify VM and ESX/ESXi Host Settings to Allow for FT Compatibility 

o Refer to sections above outlining host and VM requirements and settings 

 Use VMware Best Practices to Prepare a vSphere Environment for FT 

o Run the VMware SiteSurvey tool to verify your clusters compatibility 

o Enable host certificate checking for better security 

 Configure FT Logging 

o When creating or adding a new Vmkernel port group select the box “Use this port group for 

Fault Tolerance Logging” 
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 Prepare the Infrastructure for FT Compliance 

o Run cluster compliance check 

o Summary screen for a specified host select “Host Configured for FT” 

o Install and run the SiteSurvey plugin for vCenter 

 Test FT Failover, Secondary Restart and Application Fault Tolerance in a FT Virtual Machine 
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Objective 4.3 – Configure a vSphere Environment to support MSCS Clustering 

 

Knowledge 

 Identify MSCS Clustering Solution Requirements 

Hardware and Software Requirements 

Component Requirement 
Virtual SCSI Adapter LSI Logic Parallel for Windows Server 2003 

LSI Logic SAS for Windows Server 2008 
Operating System Windows Server 2003 SP2 or Windows Server 2008 R2 

Virtual NIC Use the default type for all guest operating systems 

I/O Timeout Set to 60 seconds or more. Modify 
HKEY_Local_Machine\System\CurrentControlSet\Services\Disk\TimeOutValue 
The system might reset this I/O timeout value if you re-create a cluster. You 
must reset the value in that case 

Disk Format Select Support clustering features such as Fault Tolerance to create disks in 
eagerzeroedthick format 

Disk and networking 
setup 

Add networking before disks. See KB 1513 

Number of nodes Use two-node clustering 

NTP server Synchronize domain controllers and cluster nodes with a common NTP server, 
and disable host-based time synchronization when using clustering in the guest 

 

Shared Storage Requirements 

Storage Type Cluster in a Box Cluster Across Boxes Standby Host Clustering 
Virtual Disks Yes (recommended) No No 

Pass-through RDM 
(Physical Compatibility 
Mode) 

No Yes 
(recommended) 

Yes 

Non-pass-through RDM 
(Virtual Compatibility 
Mode) 

Yes Yes No 

 

 Identify the Three Supported MSCS Configurations 

o Cluster in a box (single host cluster) 

 Two virtual machines on the same physical host run clustering software 

 The virtual machines share a private network connection for the private heartbeat 

and a public network connection 

 Each virtual machine is connected to shared storage, which can be local or on a SAN 

o Cluster across physical hosts 

 Two virtual machines on two different physical machines run clustering software 
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 The virtual machines share a private network connection for the private heartbeat 

and a public network connection 

 Each virtual machine is connected to shared storage, which must be on a SAN 

o Clustering physical machines with virtual machines 

 Two virtual machines, one physical the other virtual, running clustering software 

 The physical machines and virtual machines share a private network connection for 

the private heartbeat and a public network connection 

 Each machine is connected to shared storage, which must be on a SAN 

Skills and Abilities 

 Configure Virtual Machine Hardware to Support Cluster Type and Guest OS 

o See above tables for virtual machine configurations 

 Configure a MSCS Cluster on a Single ESX/ESXi Host 

o A cluster of virtual machines on one physical machine requires an ESX/ESXi host with the 

following: 

 For ESX hosts, use on physical network adapter for the service console. Use a 

separate physical network adapter for clustered virtual machines to connect with 

external hosts 

 For ESXi, use on physical network adapter for the Vmkernel. Use a separate physical 

network adapter for clustered virtual machines to connect with external hosts 

o Cluster in a box complete setup 

 
 Configure a MSCS Cluster Across ESX/ESXi Hosts 

o A cluster across physical hosts requires specific hardware and software 

 ESX/ESXi hosts that have the following: 
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 Two physical network adapters dedicated to the MSCS cluster and to the 

public and private networks 

 One physical network adapter dedicated to the service console (ESX hosts) 

or the Vmkernel (ESXi hosts) 

 Fibre Channel (FC) SAN. Shared storage must be on an FC SAN 

 RDM in physical compatibility (pass-through) or virtual compatibility (no-pass-

through) mode. VMware recommends physical compatibility mode. The cluster 

cannot use virtual disks for shared storage. Failover clustering with Windows Server 

2008 is not supported with virtual compatibility mode (non-pass-through) RDMs 

o Cluster across boxes complete setup 

 
 Configure Standby Host Clustering 

o A standby host cluster has specific hardware and software requirements 

 Use ESX/ESXi hosts that have the following 

 Two physical network adapters dedicated to the MSCS cluster and to the 

public and private networks 

 One physical network adapter dedicated to the service console (ESX hosts) 

or the Vmkernel (ESXi hosts). 

 Use RDMs in physical compatibility mode (pass-through RDM). You cannot use 

virtual disks or RDMs in virtual compatibility mode (non-pass-through RDM) for 

shared storage 

 Use the STORport Miniport driver for the Fibre Channel (FC) HBA (QLogic or Emulex) 

in the physical Windows Machine 

 Do not run multipathing software in the physical or virtual machines 

 Use only a single physical path from the host to the storage arrays in standby host 

configurations 
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Objective 4.4 – Deploy and Maintain vCenter Server Heartbeat 

 

Knowledge 

 Identify the Five Protection Levels for vCenter Server Heartbeat 

o Server Protection – vCenter Server Heartbeat provides a continuous availability to end users 

through a hardware failure scenario or operating system crash. Additionally, vCenter Server 

Heartbeat protects the network identity of the production server, ensuring users are 

provided with a replica server on the failure of the production server. 

o Network Protection – vCenter Server Heartbeat proactively monitors the network by polling 

up to three nodes to ensure that the active server is visible on the network 

o Application Protection – vCenter Server Heartbeat maintains the application environment 

ensuring that applications and services stay alive on the network 

o Performance Protection – vCenter Server Heartbeat proactively monitors system 

performance attributes to ensure that the system administrator is notified of problems and 

can take pre-emptive action to prevent an outage 

o Data Protection – vCenter Server Heartbeat intercepts all data written by users and 

applications, and maintains a copy of this data on the passive server that can be used in the 

event of a failure. 

 Identify the Three Server Protection Options for vCenter Server Heartbeat 

o vCenter Server with SQL Server on the Same Host 

o vCenter Server with SQL Server on a Separate Host 

o vCenter Server Only  

NOTE – vCenter Server Heartbeat can also be used to protect other vCenter Server components, 

granted that they are all installed on the vCenter Server. 

o VMware Update Manager 

o Site Recovery Manager 

o vCenter Linked Mode 

o Orchestrator 

 Identify Supported Cloning Options 

o The selected server architecture affects the requirements for hardware and the technique 

used to clone the Primary server. Three options are available: 

 Virtul to Virtual (V2V) – V2V is the supported architecture if vCenter Server is 

already installed on the production server running on a virtual machine. Using 

vCenter tools, create a clone of the Primary server (Pre-Clone). 

 Physical to Virtual (P2V) – P2V consists of vCenter server running on a physical 

server and the clone running on a virtual. Use of VMware Converter to create the 

cloned VM or other 3rd party utilities (Pre-Clone). 

 Physical to Physical (P2P) – In P2P configurations both the Primary and Secondary 

vCenter Servers will be used on physical hardware. Use of P2P requires the Install 
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Clone technique. vCSHB provides support for NTBackup on Windows 2003 and 

Wbadmin on Windows Server 2008 for automated Install Cloning. 

Skill and Abilities 

 Install and Configure vCenter Server Heartbeat 

o Preinstall checklist 

1. Server Architecture – V2V, P2V, P2P 

2. Cloning Technology – Pre-Clone or Install Clone 

3. Application(s) to protect – vCenter only, vCenter w/local SQL, vCenter w/remote 

SQL 

4. Network Environment Type – LAN or WAN 

5. IP Address for VMware Channel interface 

6. Identity Mode – Identical Nodes or Non-Identical Nodes 

7. If WAN, is the subnet the same at both sites 

8. Active Directory Integrated DNS? 

9. A/V Exclusions – Exclude C:\Program Files\VMware\Vmware vCenter Server 

Hearbeat\r2\logs and \log from A/V Scans 

 Determine Use Cases for and Execute a Manual Switchover 

o From the Server -> Summary Tab you can select the “Make Active” button when selected on 

either the “Primary Server” or “Secondary Server” tabs. This will transfer ownership 

between the nodes. 

 Recover From a Failover 

1. Review event logs on both server to determine the cause of the failover 

2. If any of the following issues exist on the Primary server, performing a switch back to the 

Primary server may not be possible until other important actions are carried out. Do not 

restart vCSHB until the following issues have been resolved: 

 Hard Disk Failure – Replace the defective hard disk 

 Power Failure – Restore power to the Primary server 

 Virus – Clean the server of all viruses 

 Communications – Replace or repair the physical network hardware 

 Blue Screen – Determine cause and resolve. As required, submit the dump file to 

VMware Support for analysis 

3. Run the Configure Server wizard and verify the serer identity is set to Primary and the role is 

set to passive. Click Finish to accept the changes 

4. Disconnect the VMware Channel network cables or disable the network card 

5. Resolve the list of possible failures 

6. Restart this server and reconnect or enable the network card again 

7. After restart, check that the Taskbar icon now reflects the changes by showing P/- (Primary 

and passive) 

8. On the Secondary active server or from a remote client, launch vCSHB console and confirm 

that the Secondary server is reporting as active 

 Monitor vCenter Server Heartbeat and Communication Status 
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o From the Server -> Monitoring tab you can see communication between the nodes. Also  

within the options you can configure pings and ping response times (see below). 

 Configure Heartbeat Settings  

o Configure Pings 

1. Select Server -> Monitoring tab 

2. Click Configure Pings to open the Server Monitoring: Ping Configuration dialog 

3. Click on the Ping Settings tab to configure the Ping Interval 

4. Click on the Ping Routing tab to add additional IP address for redundant NICs 

o Configure Failover 

1. Select Server -> Monitoring tab 

2. Click Configure Failover to open the Server Monitoring: Failover Configuration dialog 

3. Type a new numeric value (seconds) in the Failover timeout text box or use the 

arrow buttons to set a new value 

4. Mark or clear the check boxes to select the actions to take if the specified Failover 

timeout is exceeded. 

5. Click Ok 

o Configure Response Times 

 Time to wait following channel connection before starting replication 

 Time to wait following channel disconnection before stopping replication 

1. Select Server -> Monitoring tab 

2. Click Configure Response Times to open the Server Monitoring; Response 

Times dialog 

3. Type new numeric value (seconds) into the text boxes or use the arrow 

buttons to select new values 

4. Click OK 

 Configure Shutdown Options 

1. Select Server -> Summary tab 

2. Click Shutdown 

3. Select whether to shutdown the Primary or Secondary nodes 

If you select Primary, you receive the following two options 

 Stop protected applications 

 Do not stop protected applications 

4. Click OK 

 Configure Applications Protection 

1. Select Applications -> Summary 

2. Click Configure 

You can protect services and start monitoring applications or unprotect services and 

stop monitoring applications. You can also enable Verbose Plugin logging, Discover 

protected data at startup, Discover protected services at startup, and set the rule 

trigger count 

3. After making modifications to the configuration, click OK 
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 Add/Edit Services 

o Add a Service 

1. Right-click on a service and select Add from the menu or click Add on Applications -> 

Services page to invoke the Add Service dialog. The Name drop-down list contains a 

list of all currently running services 

2. Select the service and set the values for Target Stat on Active and Target State on 

Passive. Normally the Target State on Active is set to Running and the Target State 

on Passive is set to Stopped. 

3. If vCSHB is to manage the start and stop of the service, select Manage Starting and 

Stopping. If vCSHB is to monitor the state of the service, select Monitor State. vCSHB 

also assigns three sequential tasks to perform in the event of failure. Task options 

include Recover Service, Application Restart, Log Warning, Switchover, and any 

additional user-defined tasks previously created 

4. Assign a task to each of the three failure options and click OK 

o Edit a Service 

1. Select the service and click Edit 

2. Make the modifications and click OK 

 Add/Edit Tasks 

o Adding a Task 

1. Click Add to invoke the Add Task dialog. Assign a name to the task 

2. Select the task type from the drop-down list 

3. Select the identity of the server the task runs on (Primary or Secondary) 

4. In the Command text box, type in the path or browse to the script, .bat file, or 

command for the task to perform. 

5. Click OK 

o Edit a Task 

1. Right-click on an existing task and select Edit from the menu or select the task and 

click Edit at the top of the pane to invoke the Edit Task dialog 

2. Edit the parameters of the task 

3. Click OK 

 Edit/Test Rules 

o Edit a Rule 

1. Right-click on the rule and select Edit from the menu or click Edit at the top of the 

pane. 

2. Edit the parameters of the rule and click OK 

o Test a Rule 

1. Right-click on the rule and select Check Now from the menu or click Check Now at 

the top of the pane. The rule condition is displayed in the pane. 

 Install/Edit Plug-ins 

o Install a Plug-In 

1. Click Applications -> Plugin to open the Plugins page 
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2. Right-click an existing plug-in and select install from the menu or click Install at the 

top of the pane to invoke the Install Plugins dialog 

3. Typa a path to the plug-in location or click Browse to navigate to the plug-in 

location. The path statement is case-sensitive 

4. Click Ok 

o Edit a Plug-In 

1. Right-click on an existing plug0in from the Plugins list and select Edit from the menu 

or select the plug-in and click Edit at the top fo the pane to invoke the Edit Plugin 

dialog 

2. Review the configuration options before making modifications as they are specific 

to each plug-in 

3. Click OK 

 Add/Remove Inclusion/Exclusion Filters 

o Add a User Defined Inclusion Filter 

1. In the Data -> File Filters pane, click Add Inclusion Filter to open the Add Inclusion 

Filter dialog. 

2. Type the complete path and pattern, specify a pattern containing wildcards, or use 

Browse to locate the file or folder. 

3. Click OK 

o Add a User Defined Exclusion Filter 

1. In the Data -> File Filters pane, click Add Exclusion Filter to open the Add Exclusion 

Filter dialog. 

2. Type the complete path and pattern, specify a pattern containing wildcards, or use 

Browse to locate the file or folder 

3. Click OK 

o Remove User Defined Filters 

1. Select the filter in the File Filters list and click Remove, or right-click on the filter in 

the File Filters list and select Remove from the menu 

2. A confirmation message appears. Click Yes 

 Perform Full System and Full Registry Checks 

o Full Registry Check 

1. From the Data -> Replication tab click Full Registry Check 

o Full System Check 

1. From the Data -> Replication tab click Full System Check 

 Configure/Test Alerts 

o Configure Alerts 

1. Click Logs -> Mail Settings to open the Mail Settings dialog 

2. Type the outgoing SMTP server of both the Primary server (when active) and the 

Secondary server (when active) in the appropriate fields. 

3. Type the FQDN of the mail server. Type an email address that is authorized to send 

mail through the SMTP server 
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4. If the SMTP servers require authentication to accept and forward SMTP messages, 

select Mail Server requires authentication and specify the credentials for an 

appropriate authenticated user account. 

5. Click OK 

o Test Alerts 

1. Click Test Alert Reporting to run a test alert email. This way you can avoid triggering 

an actual alert during the operation of the active server 

 Troubleshoot Common vCenter Server Heartbeat Error Conditions 
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Section 5 – Perform Operational Maintenance 

Objective 5.1 – Implement and Maintain Host Profiles 

 

Skills and Abilities 

 Use Profile Editor to Edit and/or Disable Policies 

o On the left side of the Profile Editor, you can expand the host profile. Each host profile is 

composed of several sub-profiles that are designated by functional group to represent 

configuration instances. Each sub-profile contains many policies and compliance checks that 

describe the configuration that is relevant to the profile. 

 

Each policy consists of one or more options that contains one or more parameters. The 

parameters consist of a key and a value. The value can be one of a few basic types, for 

example integer, string, string array or integer array. 

 

The sub-profiles that may be configured are: 

Sub-Profile Configuration Example Policies and Compliance Checks 

Memory reservation Set memory reservation to a fixed value 

Storage Configure NFS Storage 

Networking Configure virtual switch, port groups, physical NIC speed, security and 
NIC teaming policies, vNetwork Distributed Switch, and vNetwork 
Distributed Switch uplink port. 

Date and Time Configure time settings, time zone of server 

Firewall Enable or disable a rule set 

Security Add a user or a usergroup, set root password 

Service Configure settings for a service 

Advanced Modify advanced options 

 

o Edit and/or Disable Policies 

1. Open the Profile Editor for the profile you wish to edit 

2. On the left side of the Profile Editor, expand a sub-profile until you reach the policy 

you want to edit 

3. Select the policy, on the right hand side of the Profile Editor, the policy options and 

parameters are displayed within the Configuration Details tab. 

4. Select a policy option from the drop-down menu and set its parameter 

5. (Optional) If you make a change to a policy, but with to revert back to the default 

option, click Revert and the option is reset 

 Create Sub-Profiles 

1. Open the Profile Editor for the profile you wish to edit 
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2. On the left side of the Profile Editor, expand a sub-profile until you reach the policy 

you want to edit (noted with a “folder” icon) 

3. Right click the policy and select “Add Profile” 

4. A new profile will be created under the give target 

5. Expand the new policy till you receive the “Configuration Details” tab in the right 

pane 

6. Configure the new policy options 

7. Click OK save and close the Host Profile 

 Use Host Profiles to Deploy vDS 

o Considerations for using Host Profiles for Deploying vDS 

 Target hosts must be in Maintenance Mode. This means all VMs must be powered 

off or migrated to other hosts. If this is a problem, consider a phased deployment or 

use the per host vDS UI migration method 

 An ESX Host Profile can be applied to ESX and ESXi hosts. An ESXi Host Profile can 

only be applied to an ESXi Host. If you have a mix of ESX and ESXi hosts, then create 

the Host Profile from an ESX host. The Host Profile feature in vCenter Server is able 

to translate and apply the ESX Service Console definition to an ESXi VMkernel port 

for management access 

o Process Overview 

1. Create vDS (without any associated hosts) 

2. Create Distributed Virtual Port Groups on vDS to match existing or required 

environment 

3. Add host to vDS and migrate vmincs to dvUplinks and Virtual Ports DV Port Groups 

4. Delete Standard Switch from host 

5. Create Host Profile of Reference Host 

6. Attach and apply host profile to candidate hosts 

7. Migrate VM networking for VMs and take hosts out of Maintenance Mode 
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Objective 5.2 – Deploy and Manage Complex Update Manager Environments 

 

Knowledge 

 Identify Firewall Access Rules for Update Manager 

Port Source Target Purpose 

80 
Update Manager 

Server 
Vmware.com & 
xml.shavlik.com 

To obtain metadata for the updates, 
Update Manager must be able to connect 
to the target sites 

80 ESX/ESXi Host Update Manager Server 
ESX/ESXi Host to Update Manager Server. 
The reverse proxy forwards the required to 
port 9084 

443 
Update Manager 

Server 
Vmware.com & 
xml.shavlik.com 

To obtain metadata for the updates, 
Update Manager must be able to connect 
to the target sites 

443 ESX/ESXi Host Update Manager Server 
ESX/ESXi Host to Update Manager Server. 
The reverse proxy forwards the required to 
port 9084 

443 vCenter Server Update Manager Server 
vCenter Server to Update Manager Server. 
The reverse proxy forwards the request to 
port 8084 

902 
Update Manager 

Server 
ESX/ESXi Host 

To push patches and updates from Update 
Manager to the ESX/ESXi Hosts to be 
updated 

1433 
Update Manager 

Server 
Microsoft SQL Server 

Update Manager to Microsoft SQL Server 
connectivity (for UM Database) 

1521 
Update Manager 

Server 
Oracle Database Server 

Update Manager to Oracle connectivity (for 
UM Database) 

8084 
Update Manager 

Server 
vCenter Server 

SOAP between components of Update 
Manger Server and the vCenter Update 
Manager client plug-in. Configurable at 
install 

9084 
Update Manager 

Server 
ESX/ESXi Host 

ESX/ESXi hosts connect to the VUM 
webserver listening for updates. 
Configurable at install 

9087 
Update Manager 

Server 
vCenter Server 

Port used for uploading host update files. 
Configurable at install 

9000-9100 ESX/ESXi Host Update Manager Server 

This is the recommend port range from 
which to choose ports for Update Manager 
if ports 80 and 443 are already in use. 
Update Manager automatically opens these 
ports for ESX Host scanning and 
remediation 

 

(Sources: VMware KB 1012382 and KB 1004543) 
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Skills and Abilities 

 Determine Use Case for, Install and Configure Update Manager Download Service 

o In certain network environments your vCenter Server and Update Manager server may not 

have access to the internet directly or may have connectivity to a host who does. In these 

instances the use of Update Manager Download Service (UMDS) to download the patch 

binaries can be used. 

o Installing UMDS – Prerequisites 

 Ensure that the machine on which you install UMDS has Internet access 

 Uninstall UMDS 1.0.x if it is installed on the machine 

 Update Manager DB needs to be configured and a ODBC connection configured on 

the host 

 UMDS and Update Manager must be installed on different machines 

o Installing UMDS 

1. Insert the VMware vCenter Update Manger installation DVD in the DVD drive 

2. Browse to the umds folder on the DVD and run VMware-UMDS.exe 

3. Select the language for the installation and click OK 

4. Review the Welcome page and click Next 

5. Read the patent agreement and click Next 

6. Accept the terms in the license agreement and click Next 

7. Select the database options and click Next 

 If you do not have an existing database, select Install a Microsoft SQL Server 

2005 Express instance (for small scale deployments) 

 If you want to use an existing database, select Use an existing supported 

database and select your database from the list of DNSs 

8. Enter the Update Manager Download Service proxy settings and click Next 

9. Select the Update Manager Download Service installation and patch download 

directories and click Next 

10. In the warning message about the disk free space, click Ok 

11. Click Install to being the installation 

12. Click Finish 

o Configuration Commands 

 To set up a download of all ESX/ESXi host updates 

Vmware-umds –set-config –enable-host 1 –enable-win 0  –enable-lin 0 

 To setup a download of all Windows updates 

Vmware-umds –set-config –enable-host 0 –enable-win 1  –enable-lin 0 

 To setup a download of all Linux updates 

Vmware-umds –set-config –enable-host 0 –enable-win 0 --enable-lin 1 

 To change the patch repository directoy 

Vmware-umds –set-config –patch-store new_folder_name 

 Exporting downloaded patches 
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Vmware-umds –E –export-store repository_path 

 

 

 Configure a Shared Repository 

o You must create the shared repository using the UMDS and host it on a web server or a local 

disk. The UMDS you use must be of a version compatible with Update Manager. Connect the 

vSphere Client to a vCenter Server system with which Update Manager is registered, and 

click Update Manager under Solutions and Applications on the Home page. Follow the 

below steps: 

1. On the Configuration tab, under Settings, click Patch Download Settings 

2. In the Patch Download Sources pane, select Use a shared repository 

3. Enter the path or the URL To the shared repository. 

For example: C:\repository_path\, https://repository_path/, or http://repository 

path 

Important Note – You cannot use folders located on a network drive as a shared 

repository. Update Manager does not download patch binaries, patch metadata, and 

notifications from folders on a network share 

4. Click Validate URL to validate the path. Make sure that the validation is successful, if 

the validation fails; Update Manager reports a reason for the failure. You can use 

the path to the shared repository only when the validation is successful. 

5. Click Apply 

6. Click Download Now to run the VMware vCenter Update Manager Update 

Download task and to download the patches and notifications immediately 

 Configure Smart Rebooting 

o Smart rebooting selectively restarts the virtual appliances and virtual machines in the vApp 

to maintain startup dependencies. You can enable and disable smart rebooting of virtual 

appliances and virtual machines in a vApp after remediation. Smart rebooting is enabled by 

default. If you disable smart rebooting, the virtual appliances and virtual machines are 

restarted according to their individual remediation requirements, disregarding existing 

startup dependencies. 

o Procedure 

1. Connect the vSphere Client to a vCenter Server system with which Update Manager 

is registered, and click Update Manager  under Solutions and Applications on the 

Home Page 

2. On the Configuration tab, under Settings, click vApp Settings 

3. Deselect Enable smart reboot after remediation to disable smart rebooting 

 Manually Download Updates to a Repository 

o Instead of using a shared repository or the Internet as a patch download source, you can 

import patches and extensions manually by using an offline bundle. You can import offline 

bundles only for hosts that are running ESX/ESXi 4.0 or later. 

o Prerequisites 

https://repository_path/
http://repository/
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 The patches and extensions you import must be in ZIP format 

 To import patches and extensions, you must have the Upload File privilege 

o Procedure 

1. Connect the vSphere Client to a vCenter Server system with which Update Manager 

is registered, and click Update Manager  under Solutions and Applications on the 

Home Page 

2. On the Configuration tab, under Settings, click Patch Download Settings 

3. Click Import Patches at the bottom of the Patch Download Sources pane 

4. On the Select Patches page of the Import Patches wizard, browse to and select the 

.zip file containing the patches you want to import 

5. Click Next and wait until the file upload completes successfully 

6. Click Next 

7. On the Confirm Import page of the Import Patches wizard, review the patches that 

you import into the Update Manager repository 

8. Click Finish 

You imported the patches into the Update Manager patch repository. You can view the 

imported patches on the Update Manager Patch Repository tab 

 Perform Orchestrated vSphere Upgrades 

o Orchestrated upgrades allow you to upgrade the objects in your vSphere inventory in a two-

step process: host upgrades followed by virtual machine upgrades. You can configure the 

process at the cluster level for higher automation, or at the individual host or virtual 

machine level for granular control. 

You can upgrade clusters without powering the virtual machine off as long as VMware 

Distributed Resource Scheduler (DRS) is available for the cluster. To perform an 

orchestrated upgrade, you must first remediate a cluster against a host upgrade baseline, 

and then remediate the same cluster against a virtual machine upgrade baseline group 

containing the VM Hardware Upgrade to Match Host and VMware Tools Upgrade to Match 

Host baselines 

 Create and Modify Baseline Group 

o Baselines contain a collection of one or more updates such as service packs, patches, 

extensions, upgrades, or bug fixes. Baseline groups are assembled from existing baselines. 

When you scan hosts, virtual machines, and virtual appliances, you evaluate them against 

baselines to determine their level of compliance. 

o Update Manager supports different types of baselines that you can use and apply when 

scanning and remediating objects in your inventory: 

1. Upgrade Baseline – Defines which version a particular host, virtual hardware, 

VMware Tools, or virtual appliance should be. With Update Manager, you can 

upgrade ESX/ESXi hosts from versions 3.x and 4.0.x to version 4.1 

2. Patch Baseline – Defines a number of patches that must be applied to a given host 

or virtual machine 
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3. Extension Baseline – Contains extensions (additional software such as third-party 

device drivers) that must be applied to a given host. Extensions are installed on 

hosts that do not have such software installed on them and pached on hosts that 

already have the software installed. All third-party software for ESX/ESXi hosts is 

classified as a host extension, although host extensions are not restricted to just 

third-party software 

o Update Manager includes default baselines that you can use to scan any virtual machine, 

virtual appliance, or host to determine whether they have all patches applied for the 

different categories or are upgraded to the latest version. The default baselines cannot be 

modified or deleted: 

1. Critical VM Patches – Checks virtual machines for compliance with all important 

Linux and all critical Windows patches 

2. Non-Critical VM Patches – Checks virtual machines for compliance with all optional 

Linux patches and Windows patches 

3. Critical Host Patches – Checks ESX/ESXi hosts for compliance with all critical patches 

4. Non-Critical Host Patches – Checks ESX/ESXi hosts for compliance with all optional 

patches 

5. VMware Tools Upgrade to Match Host – Checks virtual machines for compliance 

with the latest VMware Tools version on the host. Update Manager supports 

upgrading of VMware Tools for virtual machines on hosts that are running ESX/ESXi 

4.0 and later 

6. VM Hardware Upgrade to Match Host – Checks the virtual hardware of a virtual 

machine for compliance with the latest version supported by the host. Update 

Manger supports upgrading to virtual hardware version 7.0 on hosts that are 

running ESX/ESXi 4.0 and later 

7. VA Upgrade to Latest – Checks virtual appliances compliance with the latest 

released virtual appliance version 

8. VA Upgrade to Latest Critical – Checks virtual appliance compliance with the latest 

critical virtual appliance version 

o Create a Fixed Patch Baseline 

1. Connect the vSphere Client to a vCenter Server system with which Update Manager 

is registered, and click Update Manager  under Solutions and Applications on the 

Home Page 

2. On the Baseline and Groups tab, click Create above the Baselines pane, this will 

launch the New Baseline wizard 

3. In the New Baseline wizard, under Baseline Type, select either Host Patch or VM 

Patch, and click Next 

4. Select Fixed for the type of baseline and click Next 

5. Select individual patches to include, and clikc the down arrow to add them to the 

Fixed Patches to Add list 

6. (Optional) Click Advanced to find specific patches to include in the baseline 

7. Click Next 
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8. Review the Ready to Complete page and click Finish 

The fixed patch baseline is displayed in the Baselines pane of the Baselines and Groups 

tab 

o Create a Dynamic Patch Baseline 

1. Connect the vSphere Client to a vCenter Server system with which Update Manager is 

registered, and click Update Manager  under Solutions and Applications on the Home 

Page 

2. On the Baseline and Groups tab, click Create above the Baselines pane 

3. In the New Baseline wizard, under Baseline Type, select either Host Patch or VM Patch, 

and click Next 

4. Select Dynamic as the type of baseline, and click Next 

5. On the Dynamic Baseline Criteria page, enter criteria to define the patches to include, 

and then click Next 

6. (Optional) On the Patches to Exclude page, select one or more patches in the list nad 

click the down arrow to permanently exclude them from the baseline 

7. (Optional) Click Advance to select specific patches to exclude from the baseline 

8. Click Next 

9. (Optional) On the Other Patches to Add page, select individual patches to include in the 

baseline and click the down arrow to move them into  the Fixed Patches to Add list 

10. (Optional) Click Advanced to select specific patches to include in the baseline 

11. Review the Ready to Complete page and click Finish 

The dynamic patch baseline is displayed in the Baselines pane of the Baselines and Groups 

tab 

 Troubleshoot Update Manager Problem Areas and Issues 

 Generate Database Reports Using MS Excel or MS SQL 

o Using Microsoft Excel, you can connect to the Update Manger database and query the 

database views to generate a common report 

1. Log  in to the computer on which the Update Manager database is setup 

2. From the Windows Start menu, select Programs > Microsoft Office > Microsoft Excel 

3. Click Data > Import External Data > New Database Query 

4. In the Choose Data Source window, select VMware Update Manager and click OK 

5. In the Query Wizard – Choose Columns window, select the columns of data to include in 

your query and click Next 

6. Click OK in the warning message that the query wizard cannot join the tables in you 

query 

7. In the Microsoft Query window, drag a column name from the first view to the other 

column to join the columns in the tables manually 
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o Using a Microsoft SQL Server query, you can generate a common report from the Update 

Manager database. An example query is provided on page 162 of the VMware vCenter 

Update Manager Installation and Administration Guide. 

 Upgrade vApps Using Update Manager 

o vApps are managed in the same ways as hosts or vm’s. You will need to create a baseline 

and attach it to the vApp object. You then can perform scans and remediation’s as 

documented for hosts and vm’s. 
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Section 6 – Perform Advanced Troubleshooting 

Objective 6.1 – Configure, Manage and Analyze vSphere Log Files 

 

Knowledge 

 Identify vCenter Server Log File Names and Locations 

o There are multiple VMware vCenter Server log files pertaining to installation, performance, 

and user access. The two main VMware log files are the vpxd and vpxd-profiler logs. 

 The vpxd log is the main log file used for troubleshooting configuration and 

operational errors. The vpxd log file is automatically archived when it reaches a size 

of 5MB or when the vpxed.exe service is restarted. By default, a maximum of 10 

vpxd log files are maintained on the disk. The eight oldest log files are compressed 

to conserve disk space. To avoid filename collisions, a number is appended to the 

name of the vpxd log file. The number is incremented for each new log file 

 The vpxd-profiler log is used mainly to gather performance-related information. This 

log file is used for the VPX Operation Dashboard (VOD), which can be accessed via 

https://<VC_hostname>/vod/index.html 

o The log files are located at C:\Documents and Settings\All Users\Application 

Data\VMware\VirtualCenter\logs on Windows Server 2003 and 

C:\ProgramData\VMware\VMware VirtualCenter\Logs on Windows Server 2008 

 Identify ESX/ESXi Log Files Names and Locations 

o ESX/ESXi hosts maintain a number of log files that are useful for troubleshooting. The main 

host files are listed below: 

 Syslog – Located at /var/log/messages.  Logs are archived weekly for four weeks. 

 Host Agent – Located at /var/log/hostd.log.  

 VMKernel – Located at /var/log/vmkernel (ESX Only) 

 VMKernel Warnings – Located at /var/log/vmkwarning (ESX Only) 

 Virtual Center Agent – Located at /var/log/vmware/vmware/vpx/vpxa.log 

 Identify Tools Used to View vSphere Log Files 

o Viewing ESX Log Files 

 ESX log files can be viewed and searched from the Service-Console using standard 

Linux commands (Tail, cd, vi, etc) 

 Using the vSphere Client connected directly to an ESX host you can view the 

hostd.log, messages.log, and the vpxa.log. 

o Viewing ESXi Log Files 

 You can view ESXi log files by connecting to the direct console interface and 

selecting View System Logs from the display 

 Using the vSphere Client connected directly to an ESXi host you can view the 

hostd.log, messages.log, and the vpxa.log. 

o Viewing vCenter Server Log Files 
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 Using the vSphere Client connected to your vCenter Server you can view the log files 

for vpxd, vpxd-alert, and vpxd-profiler. Note, it will only display the two most recent 

log files 

 Using Windows Explorer and Notepad you can browse to the log files using the path 

listed above to view them. 

Skills and Abilities 

 Generate vCenter Server and ESX/ESXi Log Bundles 

o Gathering vCenter Server Log Bundles 

1. To generate a vCenter Server log bundle, select Start > Programs > Vmware and 

select either Generate vCenter Server Log Bundle – Extended or Generate vCenter 

Server Log Bundle 

o Gathering vCenter Server and ESX/ESXi Log Bundles 

1. From within the vSphere Client connected to vCenter  click Administration from 

the menu bar and select Export System Logs. This will allow you to export either 

vCenter logs, ESX/ESXi logs, are all of the above in a single zip file 

2. For ESX/ESXi you can also use the vm-support script to create a log bundle on a 

per host basis. 

3. For ESX/ESXi logs you can also connect directly via the vSphere Client to a host 

and select File > Export > Export System Logs 

 Use vicfg-syslog to Configure Centralized Logging on ESX/ESXi Hosts 

o Vicfg-syslog can be run either from using the vMA or using the vSphere CLI after passing 

connection parameters 

1. To set the syslog server 

Vicfg-syslog –setserver (-s) <IP_address_of_server> 

 To set the port of the syslog server (ESXi only)vil 

Vicfg-syslog –setport (-p) 

 To show the current configuration 

Vicfg-syslog –show (-i) 

 Test Centralized Logging Configuration 

 Configure the vMA Appliance as a Log Host 

1. Log into the vMa virtual machine as vi-admin (via Putty or console) 

2. Shut down the syslog service: 

Sudo service syslog stop 

3. Configure the syslog service to receive remote log messages by editing the 

/etc/sysconfig/syslog adding the following with the editor (using sudo) of your choice: 

SYSLOGD_OPTIONS= -r –m 0 

4. Restart the syslog service: 

Sudo service syslog start 

5. Open the firewall on vMA to allow connections: 

Sudo iptables –I INPUT –i eth0 –p udp -dport 514 –j ACCEPT 
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6. Edit the /etc/rc.local file and the iptables entry above to be processed after a system reboot 

after the line touch /var/lock/subsys/local 

7. Reboot vMA to see if options are persistent 

 Use vilogger to Enable/Disable Log Collection on the vMA Appliance 

o Enable logging per host 

1. Log into the vMA as the vi-admin user 

2. Use the vifpinit command to initialize vi-fastpast 

3. Issue the vilogger command 

Vilogger –server <ESX_or_ESXi_Host> enable 

o Enable logging for all configured hosts 

1. Log into the vMA as the vi-admin user 

2. Issue the vilogger command 

Vilogger enable 

o To display the configuration for each target: 

Vilogger list 

o Disable logging per host 

Vilogger –server <ESX_or_ESXi_Host> disable 

o Disable logging for all configured hosts 

Vilogger disable 

o Disable on a per-log basis 

Vilogger –logname <log_name> disable 

 Use vilogger to Configure Log Rotation and Retention 

o Using the vilogger enable command has the following options to modify the default 

logging behavior 

Command Option Description 

--server <host name> 
IP Address or host name of target. The 
default is all vi-fastpass targets 

--logname <name> 
Log to enable. Use vilogger list to get possible 
arguments. The default is all logs 

--collectionperiod <seconds> 
Logs are collected at regular intervals. Specify 
a number between 10 and 3600. The default 
is 10 

--numrotation <number> 
Cat Number of log files to keep before the 
oldest is removed. Specify 1-1024. The 
default is 5 

--maxfilesize <size_in_MB> 
Maximum size of the log file in megabytes 
before rollover. Specify 1-1024. The default is 
5MB 
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o Using the vilogger updatepolicy <options> command modifies the logging behavior of 

current logging settings 

Command Option Description 

--server <host_name> 
IP Address or host name of target. The 
default is all vi-fastpass targets 

--logname <name> 
Log to enable. Use vilogger list to get possible 
arguments. The default is all logs. 

--collectionperiod <seconds> 
Logs are collected at regular intervals. Specify 
a number between 10 and 3600. The default 
is 10 

--numrotation <number> 
Number of log files to keep before the oldest 
is removed. Specify 1-1024. The default is 5 

--maxfilesize <size_in_MB> 
Maximum size of the log file in megabytes 
before rollover. Specify 1-1024. The default is 
5MB 

 

 Analyze Log Entries to Obtain Configuration Information 

 Analyze Log Entries to Identify and Resolve Issues 
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Objective 6.2 – Troubleshoot CPU and Memory Performance 

 

Knowledge 

LESSON 11 

 Identify resxtop/esxtop Metrics Related to Memory and CPU 

 Identify vCenter Server Performance Chart Metrics Related to Memory and CPU 

Skills and Abilities 

 Troubleshoot ESX/ESXi Host and Virtual Machine CPU Performance Issues Using Appropriate 

Metrics 

 Troubleshoot ESX/ESXi Host and Virtual Machine Memory Performance Issues Using Appropriate 

Metrics 

 Use Hot-Add Functionality to Resolve Identified Virtual Machine CPU and Memory Performance 

Issues 
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Objective 6.3 – Troubleshoot Network Performance and Connectivity 

 

Knowledge 

 Identify Virtual Switch Entries in a Virtual Machine’s Configuration File 

o Viewing a portion of a Virtual Machine’s VMX file 

Viewin#!/usr/bin/vmware 

.encoding = "UTF-8" 

config.version = "8" 

virtualHW.version = "7" 

ethernet0.present = "TRUE" 

ethernet0.virtualDev = "vmxnet3" 

ethernet0.networkName = "VM Network" 

ethernet0.addressType = "vpx" 

ethernet0.generatedAddress = "00:50:56:89:00:01" 

vmci0.pciSlotNumber = "32" 

ethernet0.startConnected = "FALSE 

 Identify Virtual Switch Entries in the ESX/ESXi Host Configuration File 

o The /etc/vmware/esx.conf file contains information about both standard and distributed 

switches. The standard switch information will begin with the fields /net/vswitch/. Standard 

switches by default are assigned names in order: vSwitch0, vSwitch1, etc. These numbers 

relate directly to the filed /net/vswithc/child[xxx]. All entries related to distributed switches 

will being with /net/dvswitch. 

1. Using SSH connect to the ESX/ESXi Host 

2. Browse to the /etc/vmware directory 

3. Cat the esx.conf file to view its entries 

 

 Identify CLI Commands and Tools Used to Troubleshoot vSphere Networking Configurations 

o net-dvs command 

 Provides Distributed Virtual Switch information 

 Run as root or sudo from /usr/lib/vmware/bin/./net-dvs 

 Using this command other than to list information is not supported 

o Esxcfg/vicfg-vswitch 
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o Esxcfg-vswif 

o Esxcfg/vicfg-vmknic 

o Esxcfg/vicfg-route 

 Identify Logs Used to Troubleshoot Network Issues 

Skills and Abilities 

 Utilize net-dvs to Troubleshoot vNetwork Distributed Switch Configurations 

 Utilize vicfg-* Commands to Troubleshoot ESX/ESXi Network Configurations 

 Configure Network Packet Analyzer in a vSphere Environment 

o For ESX boxes you can utilize tcpdump from the Service Console or use WireShark installed 

on a virtual machine 

o To use WireShare or tcpdump you must configure packet capturing options on the virtual 

switch 

1. To monitor only port group traffic, the port group Promiscuous Mode parameter 

must be set to Accept through the vSphere Client 

2. To monitor all virtual switch traffic the virtual switch Promiscuous Mode parameter 

must be set to Accept 

3. For the service console, configure and attach an additional vswif interface to the 

switch or port group to monitor 

4. For a virtual machine, attach the virtual NIC to the switch or port group to monitor 

 Troubleshoot Private VLANs 

 Troubleshoot Service Console and VMKernel Network Configuration Issues 

 Troubleshoot DNS and Routing Related Issues 

o DNS and routing settings can be changed both via the command line an in the vSphere 

Client for ESXi 

 Using vicfg-dns 

Vicfg-dns –D <DNS_Server> --domain <Domain_Name> --hostname <Host_Name> 

 Using vicfg-route 

Vicfg-route <IP_Address> 

Vicfg-route  --del <IP_Address> 

 Using vSphere Client 

 Highlight the ESX host and click the Configuration tab 

 Click DNS and Routing 

 Click Properties 

 To change the hostname, domain, and DNS servers, click the DNS 

Configuration tab and enter the appropriate values 

o For ESX, as well as using the vSphere Client changes can be via the Service Console by 

editing a few files 

 Editing the /etc/hosts file will allow you to change the IP address and hostname 

 Editing the /etc/resolv.conf will allow you to change the name servers and the 

DNS search suffix 
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 Use esxtop/resxtop to Identify Network Performance Problems 

 Use CDP and/or Network Hints to Identify Connectivity Issues 

 Analyze Troubleshooting Data to Determine if the Root Cause for a Given Network Problem 

Originates in the Physical Infrastructure or vSphere Environment 
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Objective 6.4 – Troubleshoot Storage Performance and Connectivity 

 

Knowledge 

 Recall vicfg-* Commands Related to Listing Storage Configuration 

Command Description 

Vicfg-iscsi Manage iSCSI storage 

Vicfg-mpath 
Displays information about storage array paths and allows you to change a 
path’s state 

Vicfg-nas Manages NAS files systems 

Vicfg-rescan Rescans the storage configuration 

Vicfg-scsidevs Finds available LUNs 

Vicfg-volume 
Supports resignaturing a VMDS snapshot volume and mounting and 
unmounting the snapshot volume 
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 Recall vSphere 4 Storage Maximums 
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 Identify Logs Used to Troubleshoot Storage Issues 

o List of PSA modules loaded at boot for ESX/ESXi are located: 

 ESX - /var/log/boot-logs/sysboot.log 

 ESXi - /var/log/sysboot.log 

o Storage Events are located: 

 ESX - /var/log/vmkernel 

 ESXi - /var/log/messages 

 Describe the VMFS File System 

o VMFS stands for Virtual Machine File System 

o Clustered file system,  specially designed for storing virtual machines 

o Offers volume management so that it can support various forms of storage (local, iSCSI, or 

FC). VMFS is not used when using NFS datastores 

o VMSFS is both a LVM and file system 

o VMFS volume management writes signatures on the volume header of each new VMFS 

volume 

o Signature is a combination of the LUN number and disk serial number 

o VMFS doesn’t need defragmentation as it has thousands of large files 

Skills and Abilities 

 Use vicfg-* and esxcli to Troubleshoot Multipathing and PSA Related Issues 

o Esxcli – This command is primarily used for managing storage. It is available both in the 

service console and the vCLI. Command syntax: 

Esxcli <namespace> <app> <cmd> <cmd options> 
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Options Description 

<namespace> 
Nmp – VMware NMP commands 
swiscsi – Command in the software iSCSI name space 
corestorage – VMware core storage commands 

<app> Area within the name space to which the command applies 

<cmd> Command to be called 

<cmd options> Command options 
 Examine devices that have been claimed by the native multipathing plug-in 

Esxcli nmp device list 

 List default installed SATPs 

Esxcli nmp satp list 

 List default installed PSPs 

Esxcli nmp psp list 

 Set the PSP for a device 

Esxcli nmp device setpolicy –d <Device_ID> - -psp <PSP_Policy> 

 List information related to the native multipathing plugin for a specific device 

Esxcli nmp device list –d <Device_ID> 

 Check the preferred path 

Esxcli nmp fixed getpreferred –device <Device_ID> 

 Set the preferred path 

Esxcli nmp fixed setpreferred –device <Device_ID> --path <Run_Time_Name> 

 Change the path policy 

Esxcli nmp device setpolicy –device <Device_ID> --psp <PSP Policy> 

o Vicfg-mpath – This command is primarily used for managing storage paths. It is available 

via vCLi 

 List all multipathing plug-ins installed on your ESX/ESXi host 

Vicfg-mpath –G 

 List LUN multipathing information 

Vicfg-mpath –l 

 Disable path to a particular LUN 

Vicfg-mpath –state off –path <Run_Time_Name> 

(Source: VMware vSphere Command-Line Interface Installation and Scripting Guide) 

 Use vicfg-module to Troubleshoot Vmkernel Storage Module Configurations 

o Vicfg-module can be used to enable and disable modules as well as load/unload them. 

Modules are found at /usr/lib/vmware/vmkmod. When modules are enabled they do not 

take effect until the next host reboot. 

o Vmkload_mod can be used as well, but only allows for loading and unloading of modules for 

the VMKernel. 

 List all modules currently loaded: 



88 | P a g e  
 

Vicfg-module –list 

 Enable a given module 

Vicfg-module –enable <module name> 

 Disable a given module 

Vicfg-module –disable <module name> 

(Source: VMware vSphere Command-Line Interface Installation and Scripting Guide) 

 Use vicfg-* and esxcli to Troubleshoot iSCSI Related Issues 

 Troubleshoot NFS Mounting and Permission Issues 

 Use esxtop/resxtop and vscsiStats to Identify Storage Performance Issues 

 Configure and Troubleshoot VMFS Datastores Using vmkfstools 

o Vmkfstools is used to create and manipulate virtual disks, file systems, logical volumes, and 

physical storage devices on an ESX/ESXi host. You can use vmkfstools to create and manage 

a virtual machine file system (VMFS) on a physical partition of a disk and to manipulate files, 

such as virtual disks, stored on VMFS-3 and NFS 

o Vmkfstools File System Command Options 

Option Description 

--blocksize 
-b 

Uses the specified size for file system 
creation. Used with --createfs 

--createfs 
-C 

Creates a VMFS file system 

--queryfs 
-P 

Lists attributes of a file system 

--setfsname 
-S 

Sets the label for the file system. Used with –
createfs 

--spanfs 
-Z 

Extends the VMFS file system 

 

o Vmkfstools Virtual Disk Options 

Option Description 

--adaptertype 
-a 

Uses the specified type for disk creation 

--clonevirtualdisk 
-i 

Clones the specified virtual disk 
 

--createrdm 
-r 

Maps a raw disk to a file on a VMFS file 
system 

--createrdmpassthru 
-z 

Maps a passthrough raw disk to a file on a 
VMDS file system 

--createvirtualdisk 
-c 

Creates a virtual disk 

--deletevirtualdisk 
-U 

Deletes the specified virtual disk 

--diskformat 
-d 

Uses the specified format for disk creation 
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--extendvirtualdisk 
-X 

Extends the specified virtual disk 

--geometry 
-g 

Displays virtual disk geometry 

--inflatedisk 
-j 

Converts a thin virtual disk to 
eagerzeroedthick format, preserving all 

existing data 

--renamevirutaldisk 
-E 

Renames the specified virtual disk 

--writezeros 
-w 

Cleans the virtual disk by writing zeroes over 
all its data 

 

o Lots of commands for vmkfstools, some more common ones outlined below 

 Create a new virtual disk (assuming  in the home dir of the VM) 

Vmkfstools –c <size in K,M,or G> -d <Disk Format Listed above> filename.vmdk 

(Source: VMware vSphere Command-Line Interface Installation and Scripting Guide) 

 Troubleshoot Snapshot and Resignaturing Issues KB 1011387 

 Analyze Log Files to Identify Storage and Multipathing Problems 
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Objective 6.5 – Troubleshoot vCenter Server and ESX/ESXi Host Management 

 

Knowledge 

 Identify CLI Commands and Tools Used to Troubleshoot Management Issues 

Skills and Abilities 

 Troubleshoot vCenter Server Service and Database Connection Issues 

o vCenter Server Service  

 Runs as a Windows Service (vpxd.exe) 

 Default install location is C:\ProgramData\VMware\VMware VirtualCenter 

 Logs are located at C:\ProgramData\VMware\VMware VirtualCenter\Logs 

o vCenter Server Troubleshooting 

 Attempt to start or restart the service. If fails check log files for any errors 

 Verify the database connectivity 

 If using a remote DB make sure TCP port 1433 is open for SQL and TCP port 

1521 for Oracle 

 If running vCenter on  a 64-bit OS the DSN must be 32-bit to function 

correctly 

 Check which  Data Source is currently being used for Virtual Center 

1. Log in to the Virtual Center Server as an administrator 

2. Click Start -> Run 

3. Type regedit 

4. Navigate to HKLM\Software\VMware, Inc.\VMware 

VirtualCenter\DB 

5. The name of the Data Source that is currently being used is in the 1 

registry key. Make not of this name for use in subsequent steps 

6. Click File -> Exit without making any changes 

7. Click Start -> Control Panel -> Administrative Tools -> Data Sources 

(ODBC) 

8. Click the System DSN Tab 

9. Select the Data Source that Virtual Center is using, as noted in step 

5 

10. Click Configure 

11. On the Configure pane you see the name of the configured 

database server in the server text box. To change the Database 

server, type the name or IP address of the new server to be used 

12. Click Next 

13. Enter the appropriate login credentials on the next page 

14. Click Next 
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15. On this pane you see the database that has been configured. To 

change the database, ensure that the check box for Change the 

default database to is checked and select the database that you 

want to use for Virtual Center 

16. Click Next 

17. Click Next on the next screen, making no changes 

18. Click Finish 

19. Click Test Data Source to verify the information entered 

20. When the test completes review the information presented and 

click OK 

21. If the test was successful click OK to exit the wizard. If the test did 

not complete successfully, click Cancel and review the information 

entered to make sure it is valid 

22. Once the tst is successful click OK to exit the ODBC Data Source 

Administrator window 

 If you need to modify the username and password Virtual Center uses to 

connect to the database 

 NOTE – Ensure you are using SQL authentication if you are using MS 

SQL server because Windows NT authentication is not support 

1. Log into the VirtualCenter Server as an administrator 

2. Click Start -> Control Panel -> Add or Remove Programs 

3. Click the VMware Virtual Center Server item 

4. Click Change 

5. Click Next 

6. Select Repair 

7. Click Next 

8. Ensure that the Use an existing database server is highlighted 

9. Click Next 

10. Enter the new username and password. Ensure that the Data Source 

name is correct 

11. Click Next 

12. Click No when you are promoted with the following: “The DSN 

points to an existing VMware Virtual Center repository. Do you 

want to reinitialize the database and start over with a blank 

configuration?” 

13. Click Next through the remainder of the installation, leaving the 

default options selected 

14. On the Ready to Repair the program screen click Install 

15. When the repair is complete close out of the installer by clicking 

Finish 

 To reset the username and password manually: 

1. Log in to the Virtual Center Server as an administrator. 
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2. Click Start > Run 

3. Type regedit 

4. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\VMware, 

Inc.\VMware VirtualCenter\DB 

5. The user that is configured for database connectivity is in the 2 

registry key 

6. Right-click on the 2 key, and select modify 

7. Change the Value data to the name of the new user account 

8. Click OK 

9. Click File > Exit without making any changes 

10. Click Start > Run 

11. Type cmd 

12. Click OK 

13. Navigate to the directory VirtualCenter is installed in 

14. Type vpxd.exe –p 

15. When prompted, enter the new password and press Enter 

16. Retype the password and press Enter again to complete the 

password change 

 Verify that ports 80, 443, and 902 are not being used by any other 
applications. This can be done by using the netstat –ano command or 
Sysinternals TCPView 

 Verify that there is adequate free space on your database server for the 
transaction logs as well as the VMware database 

 Verify that critical folders exist on the Virtual Center Server host 

 C:\Documents and Settings\All Users\Application 
Data\VMware\VMware VirtualCenter\sysprep 

 C:\Documents and Settings\All Users\Application 
Data\VMware\VMware VirtualCenter\docRoot\diagnostics 

 Note: In vSphere 4.1.x and Windows 2008 (64 bit), these folders are located 
at: 
 C:\ProgramData\VMware\VMware VirtualCenter\sysprep 
 C:\ProgramData\VMware\VMware 

VirtualCenter\docRoot\diagnostics 

(Source: VMware KB Articles:KB1003926, KB1003895, KB1003928, KB4824652, KB1004280, KB1005882, and KB1003979 ) 

 Troubleshoot the ESX Service Console Firewall 
 Troubleshoot ESX/ESXi Server Management and Connectivity Issues 

 Determine the Root Cause of vSphere Management or Connectivity Issues 
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Section 7 – Secure a vSphere Environment 

Objective 7.1 – Secure ESX/ESXi Hosts 
 

Knowledge 

 Identify Configuration Files Related to Network Security 

 Identify Virtual Switch Security Characteristics 

o When you create a virtual switch for your network, you add port groups to impose a policy 

configuration for the virtual machines and storage systems attached to the switch. As part 

of adding a port or port group to a virtual switch, the vSphere Client configures a security 

profile for the port. You can use this security profile to ensure that ESX prevents the guest 

operating systems for its virtual machines from impersonating other machines on the 

network. This security feature is implemented so that the guest operating responsible for 

the impersonation does not detect that the impersonation was prevented. vSphere provides 

three vSwitch security options to provide this protection: 

 MAC Address Changes – This setting affects traffic that a virtual machine receives. 

When the option is set to Accept (Default), ESX accepts requests to change the 

effective MAC address to other than the initial MAC address. 

 

When the option is set to Reject, ESX does not honor requests to change the 

effective MAC address to anything other than the initial MAC address, which 

protects the host against MAC impersonation. The port that the virtual adapter used 

to send the request is disabled and the virtual adapter does not receive any more 

frames until it changes the effective MAC address to match the initial MAC address. 

The guest operating system does not detect that the MAC address change was not 

honored. 

 

In some situation, you might have a legitimate need for more than one adapter to 

have the same MAC address on a network – for example, if you are using Microsoft 

Network Load Balancing in unicast mode. When MS NLB is used in the standard 

multicast mode, adapters do not share MAC addresses. 

 Forged Transmissions – This setting affects traffic that is transmitted from a virtual 

machine. When the option is set to Accept (Default), ESX does not compare source 

and effective MAC addresses 

 

To protect against MAC impersonation, you can set this option to Reject. If you do, 

the host compares the source MAC address being transmitted by the operating 
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system with the effective MAC address for its adapter to see if they match. If the 

addresses do not mactch, ESX drops the packet. 

 

The guest operating system does not detect that its virtual network adapter cannont 

send packets by using the impersonated MAC address. The ESX host intercepts any 

packets with impersonated addresses before they are delivered, and the gust 

operating system might assume that the packets are dropped. 

 Promiscuous Mode Operation – Promiscuous mode eliminates any reception 

filtering that the virtual network adapter would perform so that the guest operating 

system receives all traffic observed on the wire. By default, the virtual network 

adapter cannot operate in promiscuous mode. 

Although promiscuous mode can be useful for tracking networking activity, it is an 

insecure mode of operation, because any adapter in promiscuous mode has access 

to the packets regardless of whether some of the packets are received only by a 

particular network adapter. This means that an administrator or root user within a 

virtual machine can potentially view traffic destined for other gust or host operating 

systems. 

Skils and Abilities 

 Add/Edit/Remove Users/Groups on an ESX Host 

o Adding a user to an ESX host 

1. Connect directly to the ESX host via the vSphere Client 

2. Click the Users & Groups tab and click Users 

3. Right-click anywhere in the Users table and click Add to open the Add New User 

dialog box 

4. Enter a login, a user name, a numeric user ID (UID), and a password 

 Specifying the user name and UID are optional. If you do not specify the 

UID, the vSphere Client assigns the next available UID. 

 Create a password that meets the length and complexity requirements. The 

host checks for password compliance using the default authentication plug-

in, pam_passwdqc.so. If the password is not compliant, the following error 

appears: A general system error occurred: passwd: Authentication token 

manipulation error. 

 If you switched to the pam_cracklib.so authentication plug-in, password 

compliance is not enforced 

5. To allow a user access to access the ESX host through a command shell, select Grant 

shell access to this user 

6. To add the user to a group, select the group name from the Group drop-down menu 

and click Add 

7. Click OK 
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o Edit a user account on an ESX host 

1. Connect directly to the ESX host via the vSphere Client 

2. Click the Users & Groups tab and click Users 

3. Right-click the user and click Edit to open the Edit User dialog box 

4. To change the user ID, enter a numeric user UID in the UID text box 

5. Enter a new user name 

6. To change the user’s password, select Change Password and enter the new 

password  

 Create a password that meets the length and complexity requirements. The 

host checks for password compliance using the default authentication plug-

in, pam_passwdqc.so. If the password is not compliant, the following error 

appears: A general system error occurred: passwd: Authentication token 

manipulation error. 

 If you switched to the pam_cracklib.so authentication plug-in, password 

compliance is not enforced 

7. To change the user’s ability to access the ESX hsot through a command shell, select 

or deselect Grant shell access to this user 

8. To add the user to a group, select the group name form the Group drop-down menu 

and click Add 

9. To remove the user from a group, select the group name from the Group 

membership box and click Remove 

10. Click OK 

o Remove a User or Group 

1. Connect directly to the ESX host via the vSphere Client 

2. Click the Users & Groups tab and click Users or Groups 

3. Right-click the user or group to remove and select Remove 

o Adding a Group to an ESX host 

1. Connect directly to the ESX host via the vSphere Client 

2. Click the Users & Groups tab and click Groups 

3. Right-click anywhere in the Group table and click Add to open the Create New 

Group dialog box 

4. Enter a group name and numeric group ID (GUI) in the Group ID text box 

5. For each user that you want to add as a group member, select the user namefrom 

the list and click Add 

6. Click OK 

o Add or Remove Users from a Group 

1. Connect directly to the ESX host via the vSphere Client 

2. Click the Users & Groups tab and click Groups 

3. Right-click the group to modify and select Properties to open the Edit Group dialog 

box 

4. To add the user to a group, select the group name from the Group drop-down menu 

and click Add 
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5. To remove the user from a group, select the group name form the Group 

membership box and click Remove 

6. Click OK 

o From the command line the use of the vicfg-user can be used to create users and groups 

 Customize SSH Settings for Increased Security –KB8375637, KB1019852, KB1017910 

o Enabling root access via SSH 

1. Log in to the service console and acquire root privileges 

2. Change to the /etc/ssh directory 

3. Use a text editor to open the sshd_config file 

4. Locate the line PermitRootLogin no change to yes 

5. Save your changes and close the file 

6. Restart the SSHD service 

#service sshd restart 

o Enabling Tech Support Mode from the DCUI (ESXi) 

1. At the DCUI of the ESXi host, press F2 and provide credentials when prompted 

2. Scroll to Troubleshooting Options, and press Enter 

3. If you want to enable local TSM, select Local Tech Support and press Enter once. 

If you want to enable remote TSM, select Remote Tech Support (SSH) and press 

Enter once 

4. Optionally, if you want to configure the timeout for TSM 

a) Select Modify Tech Support Timeout and press Enter 

b) Enter the desired timeout value in minutes and press Enter 

5. Press ESC three times to return to the main DCUI screen 

o Enabling Tech Support Mode from the vSphere Client 

1. Select the host and click the Configuration tab 

2. Click Security Profile -> Properties 

3. Click Local Tech Support or Remote Tech Support (SSH) and click Options 

4. Choose the desired startup policy and click Start, then click OK 

5. Verify that the daemon selected instep 3 shows as running in the Services Properties 

window 

o Configure TSM timeout value using the vSphere Client 

1. Select the host and click the Configuration tab 

2. Click Advanced Settings 

3. Change the UsersVars.TSMTimeOut filed to the desired value in minutes 

4. Click OK 

 Enable/Disable Certificate Checking 

o Host certificate checking is enabled by default and SSL certificates are used to encrypt 

network traffic. However, ESX uses automatically generated certificates that are created as 

part of the installation process and stored on the host. These certificates are unique and 

make it possible to begin using the server, but they are not verifiable and are not signed by a 

trusted-well-known certificate authority (CA). These default certificates are vulnerable to 

possible man-in-the-middle attacks. The default location for your certificate is 
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/etc/vmware/ssl/ on the ESX host. The certificate consists of two files: the certificate itself 

(rui.crt) and the private-key file (rui.key) 

o Enable and Disable Certificate Checking 

1. Log in to a vCenter Server system using the vSphere Client 

2. Select Administration -> vCenter Server Settings 

3. Click SSL Settings in the left pane and verify that Check host certificates is selected 

4. ESX - If there are hosts that require manual validation, compare the thumbprints 

listed for the hosts to the thumbprints in the host console 

To obtain the host thumbprint for ESX, run the following command 

#openssl x509 –in /etc/vmware/ssl/rui.crt –fingerprint –sha –noout 

ESXi – Log into the direct console and press F2 to access the System Customization 

menu 

Select View Support Information, the host thumbprint appears in the column on the 

right. 

5. If the thumbprint matches, select the Verify check box next to the host 

Hosts that are not selected will be disconnect after you click OK 

6. Click OK 

 Generate ESX Host Certificates (ESX) 

o The ESX host generates certificates the first time the system is started. Under certain 

circumstances, you might be required to force the hsot to generate new certificates. You 

typically generate new certificates only if you change the host name or accidentally delete 

the certificate. Each time you restart the vmware-hostd process, the mgmt-vmware script 

searches for existing certificate files. If it cannot find them, it generates new certificate files 

o Generate New Certificates 

1. In the directory /etc/vmware/ssl, back up any existing certificates by renaming them 

using the following commands: 

#mv rui.crt orig.rui.crt 

#mv rui.key orig.rui.key 

2. Use the following command to restart the vmware-hostd process 

#service mgmt-vmware restart 

3. Confirm that the ESX host successfully generated new certificates by using the 

following command and comparing the time stamps of the new certificate files with 

the original files. 

#ls –la 

 Generate ESX Host Certificates (ESXi) 

1. Select Rest Customized Settings in the direct console 

2. Reboot the system to regenerate the certificates 

 Enable ESXi Lockdown Mode 

o When you enable lockdown mode, no users other then vpxuser have authentication 

permissions, nor can they perform operations against the host directly. Lockdown mode 

forces all operations to be performed through vCenter Server. This includes running vCLI 
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commands or using the vMA against the host. You can enable lockdown mode using the Add 

Host wizard to add an ESXi hot to vCenter Server, using the vSphere Client to manage a host, 

or using the direct console user interface. 

NOTE – If you enable or disable lockdown mode using the direct console user interface, 

permissions for users and groups on the host are discarded. To preserver these permissions, 

you must enable and disable lockdown mode using the vSphere Client connect to vCenter 

Server 

o Enabling lockdown mode affects which users are authorized to access host services. The 

chart below list which services can be used by different types of users when the host is 

running in lockdown mode, compared to when the host is running in normal mode: 

Service Normal Mode Lockdown Mode 

vSphere WebServices API All users, based on ESXi 
permissions 

vCenter only (vpxuser) 

CIM Providers Root users and Admin Users vCenter only (ticket) 

Direct Console User Interface Root users and Admin users Root users 
Local Tech Support Mode Root users and Admin users No users 

Remote Tech Support Mode Root users and Admin users No users 
 

o Enable lockdown mode using the vSphere Client 

1. Log in to a vCenter Server system using the vSphere Client 

2. Select the host in the inventory panel 

3. Click the Configuration tab and click Security Profile 

4. Click the Edit link next to lockdown mode 

The Lockdown Mode dialog box appears 

5. Select Enable Lockdown Mode 

6. Click OK 

o Enable lockdown mode using the Direct Console User Interface 

1. Toggle the Configure Lockdown Mode setting 

 Replace Default Certificate with CA-Signed Certificate (ESX) 

o The ESX host uses automatically generated certificates that are created as part of the 

installation process. These certificates are unique and make it possible to being using the 

server, but they are not verifiable and they are not signed by a trusted, well-known 

certificate authority (CA). 

1. Log in to the service console and acquire root privileges 

2. In the directory /etc/vmware/ssl, rename the existing certificates using the 

following commands: 

#mv rui.crt orig.rui.crt 

#mv rui.key orig.rui.key 

3. Copy the new certificate and key to /et/vmware/ssl 

4. Rename the new certificate and key to rui.crt and rui.key 

5. Restart the vmware-hostd process for the certificates to take effect 

#service mgmt-vmware restart 
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 Replace Default Certificate with CA-Signed Certificate (ESXi) 

1. Use the vifs command to put a copy of the certificate and key files on the ESXi hsot 

The form this command takes for the certificate and key respectively is: 

#vifs –server <hostname> --username <username> --put rui.crt /host/ssl_cert 

#vifs –server <hostname> --username <username> --put rui.key /host/ssl_key 

2. Use the Restart Management Agents operation through the direct console to have 

the settings take effect 

 Configure SSL Timeouts (ESX) 

o Timeout periods can be set for two types of idle connections 

 The Read Timeout setting applies to connections that have completed the SSL 

handshake process with port 443 of ESX 

 The Handshake Timeout setting applies to connections that have not completed the 

SSL handshake process with port 443 of ESX 

Both connection timeouts are set in milliseconds. Idle connections are disconnected after 

the timeout period. By default, fully established SSL connections have a timeout of infinity 

1. Log in to the service console and acquire root privileges 

2. Change to the directory /etc/vmware/hostd/ 

3. Use a text editor to open the config.xml file 

4. Enter the <readTimeoutMs> value in milliseconds 

For example, to set the Read Timeout to 20 seconds, enter the following command 

<readTimouteMs>20000</readTimeoutMs> 

5. Enter the <handshakeTimeoutMs> value in milliseconds 

6. Save your changes and close the file 

7. Enter the following command to restart the vmware-hostd process 

#service mgmt-vmware restart 

 Configure SSL Timeouts (ESXi) 

1. Use the vifs command to get a copy of the config.xml file to edit 

Windows – vifs –server <hostname> --username <username> --get /hostconfig.xml 

<directory>\config.xml 

2. Use a text editor to open the config.xml file 

3. Enter the <readTimeoutMs> value in milliseconds 

4. Enter the <handshakeTimeoutMs> value in milliseconds 

5. Saver your changes and close the file 

6. Use the vifs command to put a copy of the config.xml file on the ESXi host 

Windows – vifs –server <hostname> --username <username> --put 

directory\config.xml /host/config.xml 

7. Use the Restart Management Agents operation through the direct console to have 

the settings take effect 

 Secure ESX Web Proxy (ESX) 

1. Log in to the service console and acuire root privileges 

2. Change to the /etc/vmware/hostd/ directory 
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3. Use a test editor to open the proxy.xml file 

4. Change the security settings as required. For example, you might want to modify 

entries for services that us HTTPS to add the option of HTTP access 

 Eid is an ID number for the server ID XML tag. ID numbers must be unique 

within the HTTP area. 

 _type is the name of the service you are moving 

 Accessmode is the forms of communications the service permits. 

Acceptable values include: 

o httpOnly – The service is accessible only over plain-text HTTP 

connections 

o httpsOnly – The service is accessible only over HTTPS connections 

o httpsWithRedirect – The service is accessible only over HTTPS 

connections. Requests over HTTP are redirected to the appropriate 

HTTPS URL 

o httpAndHttps – The service is accessible both over HTTP and HTTPS 

connections 

 port is the port number assigned to the service. You can ssign a different 

port number to the service 

 serverNamespace is the namespace for the server that provides this service, 

for example /sdk or /mob 

5. Save your changes and close the file 

6. Enter the following command to restart the vmware-hostd process: 

Service mgmt-vmware restart 

 Secure ESX Web Proxy (ESXi) 

1. Use the vifs command to get a copy of the proxy.xml file to edit 

Windows – vifs –server <hostname> --username <username> --get /host/proxy.xml 

<directory>\proxy.xml 

2. Use a text editor to open the proxy.xml file 

3. Change the security settings as required. For example, you might want to modify 

entries for services that us HTTPS to add the option of HTTP access 

 Eid is an ID number for the server ID XML tag. ID numbers must be unique 

within the HTTP area. 

 _type is the name of the service you are moving 

 Accessmode is the forms of communications the service permits. 

Acceptable values include: 

o httpOnly – The service is accessible only over plain-text HTTP 

connections 

o httpsOnly – The service is accessible only over HTTPS connections 

o httpsWithRedirect – The service is accessible only over HTTPS 

connections. Requests over HTTP are redirected to the appropriate 

HTTPS URL 



101 | P a g e  
 

o httpAndHttps – The service is accessible both over HTTP and HTTPS 

connections 

 port is the port number assigned to the service. You can ssign a different 

port number to the service 

 serverNamespace is the namespace for the server that provides this service, 

for example /sdk or /mob 

4. Save your changes and close the file 

5. Use the vifs command to put a copy of the proxy.xml file on the ESXi host 

Windows – vifs –server <hostname> --username <username> --put 

<directory>\proxy.xml /host/proxy.xml 

6. Use the Restart Management Agents operation through the direct console to have 

the settings take effect 

 Enable Strong Passwords and Configure Password Policies 

o You can impose password aging restrictions to ensure that user password do not stay active 

for long periods. ESX imposes the following password aging restrictions for user logins by 

default 

 Maximum Days – The number of days that a user can keep a password. By default 

passwords are set to never expire 

 Minimum Days – The minimum number of days between password changes. The 

default is 0, meaning that the users can change their passwords any time 

 Warning Time – The number of days in advance expiration that a reminder is sent. 

The default is seven days. Warnings are only displayed when logging directly in to 

the service console or when using SSH. 

o Change default password aging restrictions for a Host 

1. Log in to the service console and acquire root privileges 

2. To change the maximum number of days a user can keep a password, use the 

following command: 

#esxcfg-auth –pasmaxdays=<number of days> 

3. To change the minimum number of days between password changes, use the 

following command: 

#esxcfg-auth –passmindays=<number of days> 

4. To change the warning time before a password change, use the following command: 

#esxcfg-auth –passwarnage=<number of days> 

o Change default password aging restrictions for Users 

1. Log in to the service console and acquire root privileges 

2. To change the maximum number of days, use the following command: 

#chage –M <number of days> <username> 

3. To change the warning time, use the following command: 

#chage –W <number of days> <username> 

4. To change the minimum number of days, use the following command 

#chage –m <number of days> <username> 
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o Password strength and complexity – By default ESX uses the pam_passwdqc.so plugin to set 

the rules that users must observe when creating passwords and to check password strength. 

To configure password complexity, you can change the default value of the following 

parameters: 

 N0 is the number of characters required for a password that uses characters from 

only on character class. For example, the password contains only lowercase letters 

 N1 is the number of characters required for a password that uses characters from 

two character classes 

 N2 is used for passphrases. ESX requires three words for a passphrase. Each word in 

the passphrase must be 8 to 40 characters long 

 N3 is the number of characters required for a password that uses characters from 

three character classes 

 N4 is the number of characters required for a password that uses characters from all 

four character classes 

 Match is the number of characters allowed in a string that is reused from the old 

password. If the pam_passwdqc.so plugin finds a reused string of this length or 

longer, it disqualifies the string from the strength test and uses only the remaining 

characters 

Setting any of these options to -1 directs the pam_passwdqc.so plugin to ignore the 

requirement. 

Setting any of these options to disabled directs the pam_passwdqc.so plugin to disqualify 

passwords with the associated characteristic. The values used must be in descending order 

except for -1 and disabled 

o Change default password complexity for the pam_passwdqc.so plugin 

1. Log in to the service console and acquire root privileges 

2. Enter the following command: 

#esxcfg-auth –usepamqc=N0 N1 N2 N3 N4 match 

EXAMPLE – If you used the following command: 

#esxcfg-auth –usepamqc=disabled 18 -1 12 8 

With this setting in effect, a user creating a password would never be able to set 

passwords that contain only one character class. The user needs to use at least 18 

characters for a password with a two-character class, 12 characters for a three-

character class password, and eight characters for four-character class passwords. 

Attempts to create passphrases are ignored. 

o Configure a Password Reuse Rule 

1. Log into the service console and acquire root privileges 

2. Change to the directory /etc/pam.d/ 

3. Use a text editor to open the system-auth-generic file 

4. Locate the line that starts with password sufficient /lib/security/$ISA/pam_unix.so 

5. Add the following parameter to the end of the line, where X is the number of old 

passwords to store for each user. 

Remember=X 
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6. Save your changes and close the file 

7. Change to the directory /etc/security/ and use the following command to make a 

zero (o) length file with opasswd as the filename 

#touch opasswd 

8. Enter the following commands: 

#chmod 0600 opasswd 

#chown root:root /etc/security/opasswd 

 

 Identify Methods for Hardening Virtual Machines 

o Install antivirus software in the guest OS 

o Prevent Virtual Disk Shrinking 

1. Choose the virtual machines from the inventory view in the vSphere Client 

2. Clicked Edit Settings.  

3. Click Options -> Advanced/General 

4. Click Configuration Parameters to open the Configuration Parameters dialog box 

5. Add the following parameters: 

 isolation.tools.diskWiper.disable=TRUE 

 isolation.tools.diskShrink.disable=TRUE 

o Prevent other users from spying on Administrator remote consoles 

1. Choose the virtual machines from the inventory view in the vSphere Client 

2. Clicked Edit Settings.  

3. Click Options -> Advanced/General 

4. Click Configuration Parameters to open the Configuration Parameters dialog box 

5. Add the following parameter: 

 remoteDisplay.maxConnections=1 

o Disable copy/paste to remote console 

1. Choose the virtual machines from the inventory view in the vSphere Client 

2. Clicked Edit Settings.  

3. Click Options -> Advanced/General 

4. Click Configuration Parameters to open the Configuration Parameters dialog box 

5. Add the following parameters: 

 isolation.tools.copy.disable=TRUE 

 isolation.tools.paste.disable=TRUE 

 isolation.tools.setGUIOptions.enable=TRUE 

 Analyze Logs for Security-Related Messages 
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Objective 7.2 – Configure and Maintain the ESX Firewall 

 

Knowledge 

 Identify esxcfg-firewall commands 

o There are multiple switches for this command (some in more detail are in further topic 

discussions). This command only exists for ESX hosts and is not available on ESXi or the vMA. 

Here is a listing of the command switches: 

 

Command Switch Description 
-q or –query Lists current settings 

-q or –query <service> Lists setting for the specified service 

-q or –query incoming:outgoing Lists setting for non-required incoming/outgoing ports 

-s or –services Lists know services 
-l or –load Loads current settings 

-r or –resetDefaults Resets all options to defaults 

-e or –enableService <service> Allows specified service through the firewall 
-d or –disableService <service> Blocks specified service 

-o or –openPort <port,tcp|udp,in|out,name> Opens a port 

-c or –closePort <port,tcp|udp,in|out,name> Closes a port previously opened via –openPort 
--blockIncoming Block all non-required incoming ports (default value) 

--blockOutgoing Block all non-required outgoing ports (default value) 

--allowIncoming Allow all incoming ports 
--allowOutgoing Allow all outgoing ports 

-h or –help Displays command help 
 

 

 Explain the Three Firewall Security Levels 

o High Security (Default) – Firewall is configured to block all incoming and outgoing traffic, 

except for ports 22, 123, 427, 443, 902, 5989, and 5988. These are the ports used for basic 

ESX communication 

o Medium Security – All incoming traffic is blocked, except on the default ports and any ports 

you specifically open. Outgoing traffic is not blocked 

o Low Security – There are no blocks on either incoming or outgoing traffic. This setting is 

equivalent to removing the firewall. 
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 Identify ESX Firewall Architecture With/Without vCenter Server 

o Firewall Configuration with vCenter Server 
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o Firewall Configurations without vCenter Server 

 

Skills and Abilities 

 Enable/Disable Pre-Configured Services 

o Via the vSphere Client 

1. Select the host in the vSphere Client 

2. Select the Configuration tab 

3. Under the Software section select Security Profile 

4. Click Properties in the upper right hand corner 

5. Check/uncheck the required service box and click OK 

o Via a SSH connection or direct console access 

 Enable a service 

#esxcfg-firewall –e <service name> 

 Disable a service 

#esxcfg-firewall –d <service name> 

 Configure Service Behavior Automation 

o Via the vSPhere Client 

1. Select the host in the vSphere Client 

2. Select the Configuration Tab 

3. Under the Software section select Security Profile 

4. Click Properties in the upper right hand corner 

5. Select an active service (noted by a check) and click Options in the bottom right 



107 | P a g e  
 

6. From the Service Options window you can start and stop the service and change its 

Startup Policy: 

 

7. Click OK to apply changes 

 Open/Close Ports in the Firewall 

o To open a custom port 

#esxcfg-firewall –openPort <port #>,tcp|udp,in|out,<port name> 

#esxcfg-firewall –openPort 6380,tcp,in,Navisphere 

#service mgmt-vmware restart 

o To close a custom port 

#esxcfg-firewall –closePort <port#>,tcp|udp,in|out,<port name> 

#esxcfg-firewall –closePort 6380,tcp,in,Navishpere 

#service mgmt-vmware restart 

 Create a Custom Service 

o The easiest way to create your own custom service is to copy an existing xml file and make 

your changes to it. For this example I will use the ibmTSM.xml file 

1. Connect to your ESX via SSH or the local console 

2. Change to the /etc/vmware/firewall directory 

3. Copy the ibmTSM.xml file to a new file name 

#cp ibmTSM.xml NewFile.xml 

4. Open the new xml file in vi 

#vi NewFile.xml 

5. Change the following fields as required 

 <id>New Service</id> 

 <direction>inbound</direction> 

 <protocol>tcp</protocol> 

 <port type=’dst’>1550</port> 
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6. Restart the vmware management service 

#service mgmt-vmware restart 

7. Start your new service 

#esxcfg-firewall –e <Service Name> 

 Set Firewall Security Level 

o First determine the current service console security level. After doing so then make changes 

as needed. Use the following two commands to determine whether incoming or outgoing 

traffic is blocked or allowed: 

#esxcfg-firewall –q incoming 

#esxcfg-firewall –q outgoing 

o Based on the results use the below chart to gauge the security level 

Command Line Response Security Level 
Incoming ports blocked by default 
Outgoing ports blocked by default 

High 

Incoming ports blocked by default 
Outgoing ports not blocked by default 

Medium 

Incoming ports not blocked by default 
Outgoing ports not blocked by default 

Low 
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o After you have determined the current security level and you want to change it use the 

commands listed below 

 To set the service console firewall to medium security 

#esxcfg-firewall –allowoutgoing –blockIncoming 

 To set the service console firewall to low security 

#esxcfg-firewall –allowIncoming –allowOutgoing 

 To return the service console firewall to high security 

#esxcfg-firewall –blockIncoming –blockOutgoing 

 Restart the vmware-hostd process to allow the changes to take effect 

#service mgmt-vmware restart 
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Objective 7.3 – Deploy and Administer vShield Zones 

 

Knowledge 

 Identify vShield Zones Components 

o vShield Manager – vShield Manager is the centralized network management component of 

vShield, and is installed as a virtual appliance on any ESX host in your vCenter Server 

environment. A vShield Manger can run on a different ESX host from your vShield agents. 

o vShield  Zones– Provides firewall protection for traffic between virtual machines. For each 

Zones Firewall rule, you can specify the source IP, destination IP, source port, destination 

port, and service. 

 Identify the Four CLI Command Modes 

o Basic – Basic mode is a read-only mode. To have access to all commands, you must enter 

Privileged mode 

o Privileged – Privileged mode commands allow support-level options such as debugging and 

system diagnostics. Privileged mode configurations are not saved upon reboot. You must 

run the write memory command to save Privileged mode configurations. 

o Configuration – Configuration mode commands allow you to change the current 

configuration of utilities on a vShield virtual machine. You can access Configuration mode 

from Privileged mode. From Configuration mode, you can enter Interface configuration 

mode 

o Interface Configuration – Interface Configuration mode commands allow you to change the 

configuration of virtual machine interfaces. For example, you can change the IP address and 

IP route for the management port of the vShield Manager 

Skills and Abilities 

 Configure vShield Zones 

 Backup and Restore vShield Manager Data 

o Back up vShield Manager Data on demand 

1. Click Settings & Reports from the vShield Manger inventory panel 

2. Click the Configuration tab 

3. Click Backups 

4. (Optional) Select the Exclude System Events check box if you do not want to backup 

system event tables 

5. (Optional) Select the Exclude Audit Logs check box if you do not want to back up 

audit log tables 

6. Type the Host IP Address of the system where the backup will be saved 

7. (Optional) Type the Host Name of the backup system 

8. Type the User Name required to log in to the backup system 

9. Type the Password associated with the user name for the backup system 

10. In the Backup Directory field, type the absolute path where backups are to be stored 
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11. Type a text string in Filename Prefix 

12. From the Transfer Protocol drop-down menu, select either SFTP or FTP 

13. Click Backup 

14. Click Save Settings to save the configuration 

o Restore a backup of vShield Manager data 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Configuration tab 

3. Click Backups 

4. Click View Backups to view all available backups save to the backup server 

5. Select the check box for the backup to restore 

6. Click Restore 

7. Click OK to confirm 

 Backup CLI Configuration  

o The CLI Configuration option displays the running configuration of the vShield. You can back 

up the running configuration to the vShield Manager to preserve the configuration 

1. Select a vShield instance from the inventory panel 

2. Click the Configuration tab 

3. Click CLI Configuration 

4. Click Backup Configuration 

The configuration is populated in the Backup Configuration field. You can cut and paste this 

text into the vShield CLI at the Configuration mode prompt. 

 Create/Delete Layer 2/3/4 Firewall Rules Using VM Wall 

o Zones Firewall offers two sets of configurable rules: L4 (Layer 4) rules and L2/L3 (Layer 

2/Layer 3) rules. Layer 4 rules govern TCP and UDP transport of Layer 7, or application-

specific, traffic. Layer 2/Layer 3 rules monitor traffic from ICMP, ARP, and other Layer 2 and 

Layer 3 protocols. You can configure Layer 2/Layer 3 rules at the datacenter level only. By 

default, all Layer 4 and Layer 2/Layer 3 traffic is allowed to pass. 

o Create L4 firewall rule at the datacenter level 

1. Select a datacenter or cluster resource from the inventory panel 

2. Click the VM Wall tab 

3. If you are adding a rule at the datacenter level, click L4 Rules 

4. Click an existing row in the appropriate section of the tabe 

5. Click Add 

6. Double-click each cell in the new row to select the appropriate information 

7. (Optional) With the new row selected, click Up to move the row up in priority 

8. (Optional) Select the Log check box to log all sessions matching this rule 

9. Click Commit to save the rule 

o Create a L2/L3 firewall rule 

1. Select a datacenter resource from the inventory panel 

2. Click the VM Wall tab 

3. Click L2/L3 Rules 

4. Click and existing row in the Data Center Rules section of the table 
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5. Click Add 

6. Double-click each cell in the new row to type or select the appropriate information 

7. (Optional) Select the Log check box to log all sessions matching this rule. 

8. Click Commit 

 Install/Uninstall a vShield Manually and From Template Quick Start Guide 

o Deploy From a Template (Template Creation) 

1. Log in to the vSphere Client 

2. Select an ESX host from the inventory panel 

3. Go to File -> Deploy OVF Template 

4. Click Deploy from file and click Browse to locate the folder on your client machine 

containing the vShield OVF file 

5. Complete the wizard 

NOTE – DO NOT POWER ON THE VM 

6. After the wizard completes installation, convert the vShield instance into a virtual 

machine template 

o Deploy From a Template 

1. Log into the vShield Manager 

2. From the inventory tree, click the ESX host that you want to protect 

3. Click the Install vShield tab that appears above the right frame 

4. Click Configure install parameters 

5. Complete the associated form 

6. Click Continue located above the form 

7. Click Install 

8. After installation has completed, open your vSphere Client 

9. Locate the vShield in your inventory 

 Configure vShield Manager Plug-in Capability 

o The vSphere Plug-in option lets you register the vShield Manager as a vSphere Client plug-in. 

After the plug-in is registered, you can configure most vShield options from the vSphere 

Client. 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Configuration tab 

3. Click vSphere Plug-in 

4. Click Register 

5. If you are logged in to the vSphere Client, log out 

6. Log in to the vSphere Client 

7. Select an ESX host 

8. Verify that the vShield tab appears as an option 

 Configure VM Flow Charts PG45 

 Update vShield Zones 

o vShield updates are available as offline updates. When an update is made available, you can 

download the updates to your PC, and then upload the update by using the vShield Manager 
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user interface. When the update is uploaded, the vShield Manager is updated first, after 

which, each vShield App is updated. If a reboot of either the vShield Manger or a vShield 

App is required, the Update Status screen prompts you to reboot the component. In the 

event that both the vShield Manager and all vShield App instances must be rebooted, you 

must reboot the vShield Manager first, and then reboot each vShield App. 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Updates tab 

3. Click Upload Settings 

4. Click Browse to locate the update 

5. After locating the file, click Upload File 

6. Click Confirm Install to confirm update installation 

7. After the vShield Manager reboots, click the Update Status tab 

8. Click Reboot Manager if prompted 

9. Click Finish Install to complete the system update 

10. Click Confirm 

 Add/Edit/Delete User Accounts 

o Add a User 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Users tab 

3. Click Create User 

4. Type a User Name 

5. (Optional) Type the user’s Full Name for identification purposes 

6. (Optional) Type and Email Address 

7. Type a Password for login 

8. Re-type the password in the Retype Password field 

9. Click OK 

o Edit a User 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Users tab 

3. Click a cell in the table row that identifies the user account 

4. Click Update User 

5. Make changes as necessary 

6. Click OK to save your changes 

o Delete a User 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Users tab 

3. Click a cell in the table row that identifies the user account 

4. Click Delete User 

 Assign Rights to a User 

1. Click Settings & Reports from the vShield Manager inventory panel 

2. Click the Users tab 

3. Double-click the Resource cell for the user 
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4. From the drop-down menu that opens, select an available resource 

5. Double-click the Access Right cell for the user 

6. From the drop-down menu that opens, select an available access right 

 Add/Delete Application-Port Pair Mapping 

o When you click Edit Port Mappings from the Flow Monitoring tab under the Networking 

inventory object a table appears listing well-know application and protocols, their respective 

ports, and a description. vShield recognizes common protocol and port mappings, such as 

HTTP over port 80. Your organization might employ an application or protocol that uses a 

non-standard port. In this case, you can use Edit Port Mappings to identify a custom 

protocol-port pair. Your custom mapping appears on the Flow Monitoring report output. 

o Add an Application-Port Pair Mapping 

1. Go to Inventory -> Networking in the vSphere Client 

2. Select a port group from the inventory panel 

3. Click the Flow Monitoring tab 

4. Click Edit Port Mappings 

5. Click a row in the table 

6. Click Add 

7. Double-click the Application cell and type the application name 

8. Double-click the Port Number cell and type the port number 

9. Double-click the Protocol cell to select the transport protocol 

10. Double-click the Resource cell to select the container in which to enforce the new 

mapping 

11. Double-click the Description cell and type a brief decription 

12. Click Hide Port Mappings 

o Delete an Application-Port Pair Mapping 

1. Go to Inventory -> Networking in the vSphere Client 

2. Select a port group from the inventory panel 

3. Click the Flow Monitoring tab 

4. Click Edit Port Mappings 

5. Click a row in the table 

6. Click Delete to delete it from the table 

 Execute/Schedule Execution of Virtual Machine Discovery – PG53 

 Utilize vShield Zones CLI Commands to Configure and Monitor vShield Zones 

 Analyze Traffic Using VM Flow to Determine Root Cause of Network Related Issues 
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Section 8 – Perform Scripting and Automation 

Objective 8.1 – Execute VMware Cmdlets and Customize Scripts Using PowerCLI 

 

Knowledge 

 Identify vSphere PowerCLI Requirements 

 Identify CMDLET Concepts 

 Identify Environment Variables Usage 

Skills and Abilities 

 Use VMRun to Execute Commands in a Guest OS 

 Install vSphere PowerCLI 

 Install Update Manager PowerShell Library 

 Use Basic and Advanced Cmdlets to Manage VMs and ESX Hosts 

 Use Web Service Access Cmdlets 

 Use Datastore and Inventory Providers 

 Given a Sample Script. Modify the Script to Perform a Given Action 
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Objective 8.2 – Administer vCenter Orchestrator 

 

Knowledge 

 Identify vCenter Orchestrator Requirements 

o Hardware 

 2.0GHz or faster Intel or AMD x86 processor. At least two CPU’s are recommended. 

Processor requirements might differ if your database runs on the same hardware 

 4GB RAM, maybe more if your database lives on the same server 

 2GB disk space, maybe more if your database lives on the same server 

 A static IP address 

o Software 

 Supported LDAP directory (AD 2K3 and up, Novell eDirectory Server 8.8.3, Sun Java 

Directory Server Version 6.3 

 Supported web browser (MS IE 7.0, Mozilla Firefox 3.0 build 3.0.6 or later, Mozilla 

Firefox 3.5) 

 Identify Default Orchestrator Plug-ins 

o Default Plug-ins 

 vCenter 4.1 – Provides access to the vCenter 4.1 Server API 

 vCO Library – Provides workflows that act as tempates for customization and 

automation of client processes 

 Mail – Uses Simple Mail Transfer Protocol (SMTP) to send email 

 SSH – Provides an implementation of the SSH v2 protocol 

 WebOperator – A demonstration Web interface that allows you to access the 

workflows in the Orchestrator library. 

 Enumeration – Allows the creation of common enumerated types 

 Net – Wrapper to Jakarta Apache Commons Net Library 

 XML – A complete Document Object Model (DOM) XML parser 

 Database – Java Database Connectivity (JDBC) API is the industry standard for 

database independent connectivity between Java and a wide range of databases 

o Add-on Plug-ins 

 Microsoft – Provides access to WMI and reading and writing to MS AD 

Skills and Abilities 

 Install and Configure vCenter Orchestrator 

o Create Orchestrator database 

 Check dynamic port setting (1190 if using out of the box vCenter setup) 

 Create a new database 

o Start VMware Orchestrator Configuration service (default set to Manual) 

o Login to Orchestrator webpage (http://<hostname>:8282) vmware as user name and 

password 
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o Configure Networking Tab 

 Set IP address 

 Set DNS Name 

 Import vCenter SSL certificate 

o Configure LDAP 

 Set LDAP Client type (Using AD for example) 

 Set Domain Controllers 

 Set root level for LDAP 

 Set Use SSL or Global Catalog as needed 

 Set Username and Password 

 Set base LDAP path for Users 

 Set base LDAP path for Groups 

 Set base LDAP path to the vCO Admin group 

 Test login credentials 

o Configure Database Tab 

 Set database type (Using SQLServer for example) 

 Set Username and Password 

 Set Database host IP or DNS name 

 Set Port 

 Set Database Name and Instance (if needed) 

 Set Domain 

 Select “Install the Database” 

o Configure Server Certificate Tab 

 Click “Create certificate database and self-signed server certificate” 

 Set Common name 

 Set Organization 

 Set Organizational Unit 

 Set Country 

o Configure Licenses Tab 

 Select “Use vCenter Server license 

 Set Host 

 Set Port 

 Set Username and Password 

o Configure Plug-ins Tab 

 Set Username and Password 

 Select the plug-ins you would like to enable 

o Startup Options Tab 

 Select “Install vCO server as a service” 

o vCenter Server Tab 

 Click “New vCenter Server Host” 

 Set Available 

 Set Host and Port 
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 Set Username and Password 

 Set “Session per user” or “Share a unique session” 

 Set Username and Password if using “Share a unique session” 

 Configure vCenter Orchestrator Database 

o Log in to the Orchestrator configuration interface as vmware 

o Click Database 

o From the Select the database type drop-down menu, select the type of database for 

Orchestrator server to use 

o Specify the database connection parameters 

o To build or update the table structure of Orchestrator, install or update the database. 

Option Description 

Install the database Configures a new database 
Update the database Uses the database from your previous Orchestrator installation 

After the database is populated, you can reset the database access rights to db_dataread and 

db_datawriter 

o Click Apply changes 

 Configure vCenter Orchestrator LDAP Connection 

o See above 

 Configure vCenter Orchestrator vCenter Server Connections 

o See above 

 Run a Workflow – PG34 Admin Guide 

 Administer Actions, Tasks, Workflows and Policies 

 Administer Packages 

 Identify Appropriate Workflow for a Given Management Activity 
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Objective 8.3 Administer vSphere Using the vSphere Management Assistant 

 

Knowledge 

 Identify vMA Prerequisites 

 Hardware Requirements 

 ESX/ESXi host supporting 64-bit guest OS 

 AMD Opteron, rev E or later 

 vMA appliance uses 1vcpu, 5GB of storage, and 512mb of memory 

 Software Requirements 

 vSphere 4.1 

 vSphere 4.1 – You can deploy vMA to ESX/ESXi systems using a vSphere Client 

connected directly to the ESX/ESXi system or using a vSphere Client connected to a 

vCenter Server 4.0 system 

 ESX/ESXi 3.5 Update 2 and later – YOu can deploy on ESX/ESxi 3.5 Update 2 or later 

using a vSphere 4.0 client 

 vSphere Client – You need a vSphere Client for deploying vMA 

 Identify vMA Specific Commands 

 Vicfg-authconfig 

 Vicfg-cfgbackup 

 Vicfg-dns 

 Vicfg-hostops 

 Vicfg-iscsi 

 Vicfg-ntp 

 Vicfg-snmp 

 Vicfg-syslog 

 Vicfg-user 

 Vicfg-volume 

 Determine When vMA is Needed 

 Used to remotely manage ESXi 

 Central location to execute system management scripts 

 Configurable as a central syslog server via the vilogger command 

Skills and Abilities 

 Install and Configure vMA 

o Install vMA 

1. Use a vSphere Client to connect to a system that is running ESX/ESXi 4.1, 4.0, or 3.5 

Update 2 or later, or vCenter Server 4.0 

2. If connected to a vCenter Server system, select the host to which you want to 

deploy vMA in the inventory pane 

3. Select File -> Deploy OVF Template 
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4. Select Deploy from file if you have already downloaded and unzipped the vMA 

virtual appliance package 

5. Click Browse, select the OVF, and click Next 

6. Click Next when the download details are displayed 

7. Accept the license agreement 

8. (Optional) Specify a name for the virtual machine 

9. Select a location for the virtual machine when prompted 

10. If you are connected to a vCenter Server system, you can select a folder 

11. If connected to a vCenter Server system, select the resource pool for the virtual 

machine 

12. By default, the top-level root resource pool is selected 

13. If prompted, select the datastore to store the virtual machine on and click Next 

14. Select the network mapping and click Next 

15. Review the information and click Finish 

o Configure vMA 

1. In the vSphere Client, right-click the virtual machine, and click Power On 

2. Select the Console Tab 

3. Answer the network configuration prompts 

4. When prompted, specify a host name for vMA 

5. When prompted, specify a password for the vi-admin user 

This user has root privileges 

The prompt uses the Linux passwd utility 

6. vMA is now configured and prompts you to log in as vi-admin 

o Enable the vi-user account – As part of the configuration, vMA creates a vi-user account 

with no password. However, you cannot use the vi-user account unitl you have specified a 

vi-user password 

1. Log in to vMA as via-admin 

2. Run the Linux passwd command for vi-user as follows: 

#sudo passwd vi-user 

3. If you are prompted for the vMA root password, specify the vi-admin password 

4. When prompted, type and confirm the password for vi-user 

After the vi-user account is enabled on vMA, it has normal privileges on vMA but is not in 

the sudoers list. When you add ESX/ESXi target servers, vMA creates two users on each 

target: 

 Vi-admin has administrative privileges on the target system 

 Vi-user has read-only privileges on the target system. vMA creates vi-user on each 

target that you add, even if vi-user is not currently enabled on vMA. 

 Add/Remove Target Servers 

o Add vCenter Server Target (AD Authentication) 

1. Log in to vMA as vi-admin 

2. Add a server as a vMA target by running the following command: 
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#vifp addserver <FQDN of host> --authpolicy adauth –username 

<DOMAIN>\<UserName> 

3. Verify that the target server has been added 

#vifp listservers –long 

o Add vCenter Server Target Server (fastpass Authentication) 

1. Log in to vMA as vi-admin 

2. Add a server as a vMA target by running the following command: 

#vifp addserver <FQDN of Host> --authpolicy fpauth 

3. Specify the username when prompted 

4. Specify the password for that user when prompted 

5. Review and accept the security risk information 

6. Verify that the target server has been added 

#vifp listservers –long 

o Add an ESX/ESXi host as a vMA Target 

1. Log in to vMA as vi-admin 

2. Run addserver to add a server as a vMA target 

#vifp addserver <FQDN of Host> 

You are prompted for the target server’s root user password 

#root@<servername>’s password 

3. Specify the root password for the ESX/ESXi host that you want to add 

4. Verify that that target server has been added: 

#vifp listservers 

5. Set the target as the default for the current session 

#vifptarget –set | -s <server> 

6. Verify that you can run a vSPhere CLI command without authentication by running a 

command, for example 

vicfg-nics -l 

 Perform Updates to the vMA 

o To get information on a patch bulletin 

1. Log in to vMA as vi-admin 

2. Run one of the following commands: 

#sudo vma-update info 

This command gets intofmration about the bulletin in the online depot 

#sudo –vma-update info –bundle=<offline-bundelzip-url> 

Here, <offline-bundlezip-url> specifies the URL to the ZIP file in the local depot. This 

command gets information about the bulletin in the local depot 

3. (Optional) If prompted, provide the vi-admin password 

vMA lists applicable bulletins with updates 

o To scan for updates 

1. Log in to vMA as vi-admin 

2. Run the following command: 

#sudo vma-update scan 
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This command scans the bulletin in the online depot 

#sudo vma-update scan –bundle=<offline-bundlezip-url> 

Here, <offline-bundlezip-url> specifies the URL to the ZIP file in the local depot. This 

command gets information about the bulletin in the local depot 

3. (Optional) If prompted, provide the vi-admin password 

vMA lists applicable bulletins with updates 

o To update vMA 

1. Log in to vMA as vi-admin 

2. Run  sudo vma-update to install all updates or update to a particular version, 

specified by bulletin ID. Each bulletin consists of one or more updates. Later 

bulletins include the updates of previous bulletins 

TASK Command 

To update vMA to the current version Sudo vma-update update 
To update vMA to a specified update level Sudo vma-update –b <bulletined> update 
 

 Use vmkfstools to Manage VMFS Datastores 

o See Objective 6.4 Troubleshoot Storage Performance and Connectivity, section “Configure 

and Troubleshoot VMFS Datastores Using vmkfstools” 

 Use vmware-cmd to Manage VMs 

o Remote Connection String 

#vmware-cmd –server <Host> --username root <command> 

o Server operations 

 vmware-cmd -l 

 vmware-cmd -s register <config_file_path> <datacenter> <resource pool> 

 vmware-cmd -s unregister <config_file_path> 

o VM Operations 

 vmware-cmd <cfg> getstate 

 vmware-cmd <cfg> start <powerop_mode> 

 vmware-cmd <cfg> stop <powerop_mode> 

 vmware-cmd <cfg> reset <powerop_mode> 

 vmware-cmd <cfg> suspend <powerop_mode> 

 vmware-cmd <cfg> setguestinfo <variable> <value> 

 vmware-cmd <cfg> getguestinfo <variable> 

 vmware-cmd <cfg> getproductinfo <prodinfo> 

 vmware-cmd <cfg> connectdevice <device_name> 

 vmware-cmd <cfg> disconnectdevice <device_name> 

 vmware-cmd <cfg> getconfigfile 

 vmware-cmd <cfg> getuptime 

 vmware-cmd <cfg> answer 

 vmware-cmd <cfg> gettoolslastactive 
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 vmware-cmd <cfg> hassnapshot 

 vmware-cmd <cfg> createsnapshot <name> <description> <quiesce> <memory> 

 vmware-cmd <cfg> revertsnapshot 

 vmware-cmd <cfg> removesnapshots 

 Use esxcli to Manage Storage Multipathing 

o See Objective 1.3 – Configure and Manage Complex Multipathing and PSA Plug-ins for 

command examples 

 Troubleshoot Common vMA Errors and Conditions 

 

  



124 | P a g e  
 

Section 9 – Perform Advanced vSphere Installations and Configurations 

Objective 9.1 – Install ESX Server with Custom Settings 

 

Knowledge 

 Identify Service Console Memory Defaults and Maximums 

o The bare minimum that ESX will configure for the Service Console memory during 

installation is 300MB. However this is number is on a sliding scale based on the amount of 

physical memory installed in the host machine. The maximum that is configurable is 800MB. 

 Identify Default and Optional ESX Partitions 

Default Partitions 

Mount Point Type Size Location Partition Description 
/boot Ext3 The ESX boot disk requires 1.25GB of free 

space and includes the /boot and 
vmkcore partions. The /boot partition 
alone requires 1100MB 

Physical partition. 
The boot drive 
usually defaults 
to the specified 
/boot partition 
location 

Stores information required to boot 
the ESX host system. For example, 
this is where the grub boot loader 
resides. 

Not applicable  Swap 600MB recommended minimum 1600MB 
maximum. Use the default value applied 
during installation 

Virtual disk in a 
VMFS volume 

Allows ESX to use disk space when 
more memory is needed that the 
physical RAM allows. Note- Do not 
confuse the ESX swap partition with 
virtual machine swap space. 

/ Ext Calculated dynamically based on the size 
of the /usr partition. By default, the 
minimum size is 5GB and no /user 
partition is defined 

Virtual disk in a 
VMFS volume 

Contains the ESX operating system 
and services, accessible through 
the service console. Also contains 
third-party add-on services or 
applications you install 

Not applicable VMFS3 Esxconsole.vmdk:1200MB Physical partition 
located on one of 
the following: 
Local or boot 
drive, local SCSI 

volume, 
Networked  SCSI 
volume, SAN. The 
service console 
must be installed 
on a VMFS 
datastore that is 

resident on a 
host’s local disk 
or on a SAN disk 
that is masked 
and zoned to that 
particular host 
only 

Used to store core dumps for 
debugging and technical support. If 
multiple ESX hosts share a SAN, 
configure a vmkcore partition with 
100MB for each host. 

Not applicable vmkcore The ESX boot disk requires 1.25GB of free 
space and includes the /boot and 
vmkcore partitions. The /boot partition 
alone requires 1100MB 

Physical partition 
located on on of 
the following: 
Local SCSI 
volume, 
Networked SCSI 

volume, SAN. 
Cannot be located 
on a software 
iSCSI volume 

Used to store core dumps for 
debugging and technical support. If 
multiple ESX hosts share a SAN, 
configure a vmkcore partition with 
100MB for each host. 
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Optional Partitions 

Mount Point Type Recommend Size Location Partition Description 
/home Ext3 512MB Virtual disk in a 

VMFS volume 
Used for storage by individual users 

/tmp Ext3 1024MB Virtual disk in a 
VMFS volume 

Used to store temporary files 

/usr Ext3  Virtual disk in a 
VMFS volume 

Used for user programs and data 

/var/log Ext3 2000MB Virtual disk in a 
VMFS volume 

Used to store log files. The graphical 
and text installers create this 200MB 
partition by default 

 

Skills and Abilities 

 Configure Optional ESX Partitions During Installation 

o The optional partitions can be created via both the graphical interface and scriptable 

installations. 

 Install/Uninstall Custom Drivers 

o You might need custom drivers if your system is not listed in the Hardware Compatibility 

Guide and has a network or storage device that was not originally compatible with ESX. 

These custom drivers can be installed during installation (both graphical and scripted) as 

well as added after the system has been installed. NOTE – If you PXE booted the ESX 

installer, you cannot install custom drivers during the installation process, you must wait 

until after ESX has been installed. 

 Configure Advanced Bootloader Options 

o When using the graphical install select the Advanced Setup and clear the Configure boot 

loader automatically check box, this will allow for the configuration of the boot loader as 

well as Kernel options. For the boot loader you can configure a bootloader password as well 

as the location of GRUB (first partition instead of the Master Boot Record). 

 Configure Kernel Options 

o Also when selecting the Advanced Setup you can specify Kernel options. These can also be 

configured via the vSphere Client under Advanced Settings -> VMkernel -> Boot under the 

Configuration tab of an ESX host or from the command line with the vicfg-advcfg command. 

 To list all available VMkernel advanced configurations 

#vicfg-advcfg –list 

 To get the value of a specific configuration 

#vicfg-advcg –get <Configuration Option> 

 To set the value of a specific kernel configuration 

#vicfg-adccfg –set-kernel  <Configuration Value> <Configuration Option> 

EXAMPLE - #vicfg-advcfg –set-kernel true fsCheck 

 

 Given a Scenario, Determine When to Customize a Configuration 
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Objective 9.2 – Plan and Execute Scripted Installations 

 

Knowledge 

 Identify Default Installation Scripts 

o Ks-first.cfg installs ESX on the first detected disk and uses default partitioning. This script is 

run if you select ESX Scripted Install to first disk (overwrite VMFS) option in the boot options 

menu. 

o Ks-first-safe.cfg installs ESX on the first detected disk and preserves the VMFS datastores on 

the disk. 

o After your first interactive installation of ESX, the installer creates a /root/ks.cfg script in the 

ESX file system. This script reflects the choices you made in the interactive installation. If you 

perform a second interactive installation on the same host with choices that differ from the 

first, /root/ks.cfg is overwritten with a new version. 

 Identify Boot Options for Scripted Installation 

o Before the ESX installer Welcome screen appears, the installer displays a boot prompt 

where you can enter boot commands to pass arguments to the installer. Press Tab quickly 

from the mode selection screen to allow for the use of these commands. 

Command Description 
askmedia Allows you to interactively select the location of the ESX 

installation media. This option is required if the image is 
hosted at an HTTP, FTP, or NFS location 

BOOTIF Accepts the format for the boot network adapter as supplied 
by PXELINUX 

gateway= <IP Address> Sets this network gateway as the default gateway during the 
install 

ip=<IP Address Specifies a static IP address to be used for downloading the 
script and the installation media 

ks=cdrom:/<patch> Performs a scripted installation with the script at <path> 
which resides on the DVD in the DVD-ROM drive 

ks=file://<path> Performs a scripted installation with the script at <path> 
which resides inside the initial ramdisk image 

ks=ftp://<server>/<path> Performs a scripted installation with a script located at the 
given URL 

ks=http://<server>/<path> Performs a scripted installation with a script located at the 
given URL 

ks=https://<server>/<path> Performs a scripted installation with a script located at the 
given URL 

ks=nfs://<server>/<path> Performs a scripted installation with a script located at <path> 
on a give NFS server 

ks=UUID:<partition-UUID>:/<path> Performs a scripted installation with a script located on the 
ext partition with the give UUID 

ksdevice=<device> Same as netdevice 

mediacheck Checks the MD5 sum of the DVD media to make sure the 
information is not corrupt. The media check operation adds 
several minutes to the installation process 

mem=(required) Reserves a minimum amount of memory for the ESX service 
console. The value must be at least 512M 

nameserver=<IP Address> Specifies a domain name serve as the nameserver during the 
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install 

netdevice=<device> Tries to use a network adapter <device> when looking for an 
installation script and installation media. Specify as a MAC 
address. If not specified and files need t be retrieved over the 
network, the installer defaults to the first discovered network 
adapter 

netmask=<subnet mask> Specifies subnet mask for the network interface that 
downloads the installation media 

noapic Flags the kernel to use the XTPIC instead of the APIC 

text Starts the ESX installer in text mode 

url=<url> Looks for the installation media at the specified URL. When 
you are PXE booting the installer, the url= command only 
works with earlier versions of SYSLINUX. The command does 
not work with SYSLINUX/PXELINUX version 3.70 and higher 

vlandid=<VLANID> Configures the VLAN for the network card 

 

Skills and Abilities 

 Perform a Scripted ESX Host Installation 

 Perform a Scripted ESXi Host Installation 

 Configure Media Repository 

o The media depot is a network-accessible locaton that contains the ESX installation media. 

You can use HTTP/HTTPS, FT, or NFS to provide access to the depot. The depot must be 

populated with the entire contents of the ESX installation DVD, preserving directory 

structure. For a scripted installation, you must point to the media depot in the script by 

including the install command with the nfs or url option. 

 Edit Installation Script Parameters 

o You can manually edit the default scripts ks.cfg (ESXi), ks-first.cfg, and ks-first-safe.cfg (ESX) 

to your needs. Also, after completing an installation of ESX the configuration used is saved 

to /etc/ks.cfg. You can this use this file to perform further installs of other hosts with slight 

configuration changes. 

 Configure Pre/Post Script Tasks 

o %Pre Tasks – You can us this option to specify a script to be run before the kickstart 

installation script is evalueated. 

o %Post Tasks – You can us this option to include a script or commands that will be executed 

after the installation process has completed. 

 Evaluate Use Cases for Scripted Installation 

o Scripted installations are best used in large environments (10 or more hosts) as there will be 

a time saving in the long run of building/rebuilding hosts compared to the time it takes to 

test and develop a scripted install. Smaller shops (less than 10 hosts)might find it easier and 

quicker to install and configure manually. 
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Objective 9.3 – Configure vCenter Server Linked Mode 

 

Knowledge 

 Identify Linked Mode Prerequisites 

 Identify Differences Between Linked and Non-linked vCenter Server Configurations 

 Identify When a Role Requires Reconciliation 

Skills and Abilities 

 Reconcile Roles in a Linked Mode Configuration 

 Create and Join a Linked Mode Group 

 Determine Use Cases for vCenter Server Linked Mode 

 Troubleshoot Linked Mode Configurations 

 


